## ROOT Workshop 2020

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Data Analysis Using ROOT</td>
<td>3</td>
</tr>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>A guide to this tutorial</td>
<td>4</td>
</tr>
<tr>
<td><strong>Part One – The Basics</strong></td>
<td>5</td>
</tr>
<tr>
<td>Getting started with Linux on the Nevis particle-physics systems</td>
<td>5</td>
</tr>
<tr>
<td>Using your laptop</td>
<td>6</td>
</tr>
<tr>
<td>A Brief Intro to Linux</td>
<td>7</td>
</tr>
<tr>
<td>Walkthrough: Setting up ROOT (5 minutes)</td>
<td>10</td>
</tr>
<tr>
<td>Walkthrough: Starting ROOT (5 minutes)</td>
<td>11</td>
</tr>
<tr>
<td>Walkthrough: Plotting a function (15 minutes)</td>
<td>12</td>
</tr>
<tr>
<td>Walkthrough: Plotting a function (continued)</td>
<td>14</td>
</tr>
<tr>
<td>Exercise 1: Detective work (10 minutes)</td>
<td>15</td>
</tr>
<tr>
<td>Walkthrough: Working with Histograms (15 minutes)</td>
<td>16</td>
</tr>
<tr>
<td>Walkthrough: Saving and printing your work (15 minutes)</td>
<td>18</td>
</tr>
<tr>
<td>Walkthrough: The ROOT browser (5 minutes)</td>
<td>19</td>
</tr>
<tr>
<td>Walkthrough: Fitting a histogram (15 minutes)</td>
<td>20</td>
</tr>
<tr>
<td>Walkthrough: Saving your work, part 2 (15 minutes)</td>
<td>25</td>
</tr>
<tr>
<td>Walkthrough: Variables in ROOT NTuples/Trees (10 minutes)</td>
<td>26</td>
</tr>
<tr>
<td>Using the Treeviewer</td>
<td>28</td>
</tr>
<tr>
<td><strong>Part Two – The Notebook Server</strong></td>
<td>33</td>
</tr>
<tr>
<td>Starting with Jupyter (5 minutes)</td>
<td>33</td>
</tr>
<tr>
<td>Your first notebook (10 minutes)</td>
<td>34</td>
</tr>
<tr>
<td>Magic commands (5 minutes)</td>
<td>36</td>
</tr>
<tr>
<td>Markdown cells (5 minutes)</td>
<td>37</td>
</tr>
<tr>
<td>The ROOT C++ kernel (5 minutes)</td>
<td>38</td>
</tr>
<tr>
<td><strong>Decisions</strong></td>
<td>39</td>
</tr>
<tr>
<td>C++ or Python?</td>
<td>39</td>
</tr>
<tr>
<td>Command-line or notebook?</td>
<td>40</td>
</tr>
<tr>
<td>Diagonalizing the 2x2 decision matrix</td>
<td>42</td>
</tr>
<tr>
<td><strong>Part Three – The C++ Path</strong></td>
<td>43</td>
</tr>
<tr>
<td>Walkthrough: Simple analysis using the Draw command (10 minutes)</td>
<td>43</td>
</tr>
<tr>
<td>Pointers: A too-short explanation (for those who don’t know C++ or C)</td>
<td>44</td>
</tr>
<tr>
<td>Walkthrough: Simple analysis using the Draw command, part 2 (10 minutes)</td>
<td>45</td>
</tr>
<tr>
<td>Walkthrough: Using C++ to analyze a Tree (10 minutes)</td>
<td>46</td>
</tr>
<tr>
<td>Walkthrough: Using C++ to analyze a Tree (continued)</td>
<td>47</td>
</tr>
<tr>
<td>Walkthrough: Running the Analyze macro (10 minutes)</td>
<td>48</td>
</tr>
<tr>
<td>Walkthrough: Making a histogram with Analyze (15 minutes)</td>
<td>49</td>
</tr>
<tr>
<td>Exercise 2: Adding error bars to a histogram (5 minutes)</td>
<td>51</td>
</tr>
<tr>
<td>Exercise 3: Two histograms in the same loop (15 minutes)</td>
<td>52</td>
</tr>
<tr>
<td>Exercise 4: Displaying fit parameters (10 minutes)</td>
<td>53</td>
</tr>
<tr>
<td>Exercise 5: Scatterplot (10 minutes)</td>
<td>53</td>
</tr>
<tr>
<td>Walkthrough: Calculating our own variables (10 minutes)</td>
<td>54</td>
</tr>
<tr>
<td>Exercise 6: Plotting a derived variable (10 minutes)</td>
<td>55</td>
</tr>
<tr>
<td>Exercise 7: Trig functions (15 minutes)</td>
<td>55</td>
</tr>
<tr>
<td>Walkthrough: Applying a cut (10 minutes)</td>
<td>56</td>
</tr>
</tbody>
</table>
Exercise 8: Picking a physics cut (15 minutes) ................................................................. 57
Exercise 9: A bit more physics (15 minutes) ........................................................................ 58
Exercise 10: Writing histograms to a file (10 minutes) ...................................................... 58
Exercise 11: Stand-alone program (optional) (60 minutes or more if you don’t know C++) ... 59

Part Four – The Python with pyroot Path ........................................................................... 61
A brief review (5 minutes) ..................................................................................................... 61
Differences between C++ and Python .................................................................................. 62
Walkthrough: Simple analysis using the Draw command (10 minutes) ................................ 64
Walkthrough: Simple analysis using the Draw command, part 2 (10 minutes) .................... 65
Walkthrough: Using Python to analyze a Tree (10 minutes) ................................................ 66
Walkthrough: Using the Analyze script (10 minutes) .......................................................... 68
Exercise 2: Adding error bars to a histogram (5 minutes) .................................................... 70
Exercise 3: Two histograms in the same loop (15 minutes) .................................................. 71
Exercise 4: Displaying fit parameters (10 minutes) .............................................................. 72
Exercise 5: Scatterplot (10 minutes) .................................................................................... 72
Walkthrough: Calculating our own variables (10 minutes) .................................................. 73
Exercise 6: Plotting a derived variable (10 minutes) ............................................................ 74
Exercise 7: Trig functions (15 minutes) ................................................................................ 74
Walkthrough: Applying a cut (10 minutes) ......................................................................... 75
Exercise 8: Picking a physics cut (15 minutes) .................................................................... 76
Exercise 9: A bit more physics (15 minutes) ....................................................................... 77
Exercise 10: Writing histograms to a file (10 minutes) ....................................................... 77
Exercise 11: Stand-alone program (optional) (30 minutes) ................................................. 78

Part Five – Intermediate topics (for both ROOT/C++ and pyroot) ....................................... 79
References ............................................................................................................................ 79
Advanced histogramming notes .......................................................................................... 80
Directories ............................................................................................................................ 82
JupyterLab ............................................................................................................................. 84
Dataframes ........................................................................................................................... 86
uproot .................................................................................................................................. 88
Installing ROOT on your own computer ............................................................................ 89

Part Six – Advanced Exercises ......................................................................................... 94
Working with folders inside ROOT files ............................................................................. 94
C++ Container classes ........................................................................................................ 95
Exercise 12: Create a basic x-y plot (1-2.5 hours) ............................................................... 98
Exercise 13: A more realistic x-y plotting task (1-2 hours) ................................................ 102

Part Seven – Expert Exercises ............................................................................................ 103
Exercise 14: A brutally realistic example of a plotting task (1-2 hours) ............................... 103
Exercise 15: Data reduction (1-2 hours) ............................................................................. 106
Wrap-up ............................................................................................................................... 110

Version History .................................................................................................................. 111
**Introduction**

This tutorial started as a one-day class I taught in 2001. Over the years, I’ve revised it as different versions of ROOT came out, and in response to comments received from the students.

Many parts of this tutorial are optional or are advanced exercises. No one expects you to get through all 112 pages before you start your physics work for the summer. Much of the material, especially from Part Five on, is intended to use as a reference if you continue to use ROOT in the future.

The lessons have time estimates at the top. These are only rough estimates. Don't be concerned about time. The important thing is for you to learn something, not to punch a time clock.

If you’re programming for the first time, then it will probably take you more than a half-day per part. Someone with years of prior experience in ROOT and C++ or Python might barely get through all seven parts in two days.

On the other hand, if the class seems too easy, just keep going; I gradually ramp up the difficulty. The lessons do not stay at the level of “ROOT does what physicists do.”

You can find this tutorial in PDF format (along with links to the sample files and references) at <http://www.nevis.columbia.edu/~seligman/root-class/>.

At the end of the summer, let me know what you found useful or useless to you. I’ll consider your suggestions for next year’s workshop.

Have fun!
A guide to this tutorial

If you see a command in this tutorial that’s preceded by “[]”, it means that it is a ROOT command. Type that command into ROOT without the “[]” symbols. For example, if you see

```
[] .x treeviewer.C
```

it means to type `.x treeviewer.C` at a ROOT command prompt.

If you see a command in this tutorial preceded by “>” it means that it is a UNIX shell command. Type that command into UNIX, not into ROOT, and without the “>” symbol. For example, if you see

```
> man less
```

it means to type `man less` at a UNIX command prompt.

If you take the Python part of this tutorial, the prompt is “In []”. For example:

```
> ipython
In[] from ROOT import TH1
```

Paragraphs in this style are hints, tips, and advice. You may be able to get through this tutorial without reading any of this text... but I wouldn’t count on it!

If you’re sharp of eye and keen of sight, you’ll also notice that I use different styles for Linux commands, program names and variables, and menu items. ROOT, Python, and Jupyter will put a session line number in brackets; e.g., [0], [1], [2]; In [0], In [1], In [2]. I’ll omit the line numbers from this tutorial.

Figure 1: [http://xkcd.com/1343](http://xkcd.com/1343) by Randall Munroe
Part One – The Basics

**Getting started with Linux on the Nevis particle-physics systems**

If you're sitting in front of a desktop computer running Linux, just use your account name and password to login.

Click **once** on the Browser icon (at the top or bottom of the screen) to start a web browser. This either looks like the standard Firefox icon, or like a sphere with a mouse around it.

Type the following URL in the **Location** field of the web browser: [http://root.cern.ch/](http://root.cern.ch/). This is the ROOT web site. You'll be coming back here often, so be sure to bookmark it. You may also want to bookmark the User’s Guide for a handy reference: click on **Documents**, then on the **User’s Guide – 6 series** link.

You'll need to open a terminal session to do your work. The menu path is:

```
Applications -> Accessories -> Terminal
```

If you see a prompt about initializing zsh, just hit “q”.

You may find it convenient to add the Terminal application icon to the menu bar or to your desktop. You can do this by selecting **Applications->Accessories->Terminal** on the menu bar, but right-click on the word **Terminal** instead of just releasing the left button. That will give you options to create icons on the desktop or the “panel” (menu bar).

Initially (for the ROOT class), you’ll probably be content just to login to the student computers and start working. When you start your real work for this summer, I suggest that you **ssh** to the main server for your experiment; it’s the one listed on “Summer Student Accounts” sheet that I handed out before the class.
Using your laptop

Mac and Linux

You can connect to the main server for your experiment by running a terminal window and using

```
ssh -X -Y <server-name>.nevis.columbia.edu
```

On the Mac, you’ll find the Terminal application in Applications/Utilities. On Mac OS 10.7 and above, you’ll need to install XQuartz: http://xquartz.macosforge.org

Windows

To connect to a Linux server from Windows, you need ssh and an X-Windows emulator. I recommend MobaXterm, which includes both: http://mobaxterm.mobatek.net/.

Connecting to the notebook server

This will be described in detail in Part Two. In short: go to https://notebook.nevis.columbia.edu (note that it’s “https”, not just “http”) and use your Nevis Linux cluster account name and password.

Installing ROOT on your laptop

Don’t.

If the above paragraph is too short and snarky for you, I’ll elaborate: You may correctly deduce that setting up ROOT on your own computer system is not a trivial task. It is not an app you can double-click to install. With all the hassle, I suggest logging into our servers or using the notebook server for this course if you are able to do so.

The reason why I installed ROOT on our Nevis systems and prepared the notebook server is so you can spend less time on software installations, and more time on learning how to use the tools to do physics. Let’s do physics.

If the above is not enough to dissuade you, or you don’t have a choice because you don’t have an on-line connection to Nevis, I discuss the nitty-gritty details of installing ROOT in Part Five, starting on page 79.

---

1 That’s dash capital-X, dash capital-Y. If you get tired of remembering to type -X -Y whenever you type `ssh`, edit the file ~/.ssh/config in your home directory and add the lines:

```
ForwardX11 = yes
ForwardAgent = yes
```

Don’t bother including them if you’re `ssh`’ing into your workgroup’s server from the desktop systems in the Nevis research building; they’re the default.

2 In the 2019 ROOT class the students discovered that if you fiddle with the Mac OS X Darwin environment variable `DYLD_LIBRARY_PATH`, XQuartz may not work properly. Most users don’t set the value of this variable, but since you’re studying scientific research you may have installed software (such as Anaconda, MacPorts, or Homebrew) that affects your environment variables.

If you’re having problems with XQuartz, check your shell start-up scripts (e.g., `.zshrc`, `.bash_profile`, `.cshrc`). If you see `DYLD_LIBRARY_PATH` is altered, you might want to comment out that line and open a fresh Terminal window before running XQuartz.
A Brief Intro to Linux

If you're already familiar with Linux, skip or skim this section.

You can spend a lifetime learning Linux; I've been working with UNIX since 1993 and I'm still learning something new every day. The commands below barely scratch the surface.

There are links at http://www.nevis.columbia.edu/~seligman/root-class/links.html to sites that can teach you more about Linux.

To copy a file: use the **cp** command.³

For example, to copy the file CreateSubdirectories.C from the directory ~seligman/root-class to your current working directory, type:⁴

> cp ~seligman/root-class/CreateSubdirectories.C $PWD

In UNIX, the $PWD means the results of the **pwd** ("print working directory") command.⁵

To look at the contents of a text file: Use the **less** command.⁶

This command is handy if you want to quickly look at a file without editing it. To browse the contents of file CreateSubdirectories.C, type:

> less CreateSubdirectories.C

While **less** is running, type a space to go forward one screen, type b to go backward one screen, type q to quit, and type h for a complete list of commands you can use.

---
³ As more and more students have begun to use laptops, I noticed that many of them had an interesting misconception: The **cp** command copies a file from one directory to another in the same computer system. It does *not* copy a file to your laptop! For that you use the **scp** command; see the next page for how to learn about any UNIX command.
⁴ It’s always “~seligman” (tilde-seligman), never “–seligman” (dash-seligman). Depending on the exact font used to print or display this tutorial, sometimes tildes look like dashes. On most keyboards, tilde is typed with SHIFT-` where ` (backtick) is on the upper-left-hand corner of the keyboard. In UNIX ~jsmith means “the home directory of the jsmith account.” Just plain ~ means your own home directory.
⁵ A period (.) is the usual abbreviation in UNIX for “the current directory,” but many students missed the period the first time I taught this class.
⁶ If the name is confusing: the **less** command was created as a more powerful version of the **more** command.
A Brief Intro to Linux (continued)

To get help on any UNIX command: type `man <command-name>`

While `man` is running, you can use the same navigation commands as `less`. For example, to learn about the `less` command, type:

```
> man less
```

To edit a file: I suggest you use `emacs`.7

You will almost always want to add an ampersand (&) to the end of any `emacs` command; the ampersand means to run the command as a separate process. To edit a file with the name `CreateSubdirectories.C`, type:

```
> emacs CreateSubdirectories.C &
```

The `emacs` environment is complex, and you can spend a lifetime learning it.8 For now, just use the mouse to move the cursor and look at the menus. When you get the chance, I suggest you take the `emacs` tutorial by selecting it under the "Help" menu.

Learn how to cut and paste in whatever editor you use. If you don’t, you’ll waste a lot of time typing the same things over and over again.

Are you quitting `emacs` after you change a file, only to start up the editor again a moment later? Hint: look at the File menu. If you’re editing many files, try opening them all with File->Open File… and switch between them using the Buffers menu.

---

![Figure 3: xkcd.com/378 by Randall Munroe](http://xkcd.com/378)

If you’re feeling bored, type Meta-x butterfly in `emacs` and see what happens.

---

7 If you're already familiar with another editor, such as `nano` or `vim`, you can use it instead. If you’re using `emacs` on your Mac, you’ll get the screen-based version instead of the window-based version; do not put & after the command.

8 I’ve spent two of your lifetimes already, and the class has just started!
A Brief Intro to Linux (optional)

Here are a few Linux tricks than can make your life easier.

Using the command line

When you’re typing commands in ROOT, IPython, or UNIX, your two best friends are the TAB key and the up-arrow key.

Try it: On the UNIX command line, type (<TAB> means to hit the TAB key):

```
> cp ~seli<TAB>roo<TAB>Cro<TAB>S<TAB> $PWD
```

You’ll see how UNIX does its best to fill in the remainder of a word, up to the point for which there’s a choice.

Now list the contents of files in your current directory:

```
> ls
```

Let’s execute that copy command again. You don’t have to type it again, even with the help of tab-completion; just hit the up-arrow key twice and press ENTER.

Did you look at the emacs tutorial I mentioned on the previous page? If you did, you saw that it starts with a discussion of using special keypresses for cursor navigation. Perhaps you thought, “Have they never heard of a mouse?” If you did, you were right: the emacs tutorial was written before GUIs and computer mice were known outside of Xerox PARC.

Why is that tutorial useful, even though it’s no longer the 1970s? Because those same key-based navigation commands work on the UNIX and ROOT command lines.

You don’t have to type the long commands in this tutorial, at least not more than once. With the help of tab-completion, the up-arrow key, navigation keypresses, and cut-and-paste, you can edit your previous commands for new tasks.

Don’t get too GUI

You’re probably used to a graphical user interface (GUI) instead of the command line; for example, opening a file with an appropriate application by double-clicking on its icon in a window. For copying and editing files, or developing code, I recommend against a GUI; almost all physics development work is done on the command line.

However, if all you’re going to do is read a file, it’s OK to double-click it in a file-manager window and let UNIX pick an application for you.

This GUI advice won’t apply if you start using ROOT notebooks. We’ll get to that later.

---

9 If you ask me to help you with a problem during the class and I start typing commands for you, you’re going to see me use the up-arrow key, then Ctrl-A, Ctrl-E, Meta-F, and Meta-B to jump the cursor through the commands you’ve typed and make changes.

I’ve grown so used to those navigation commands that when I edit a file, I use `emacs -nw` (for “no windows”) and skip the GUI features like menus and mouse-clicks. It’s faster for me to keep my hands on the keyboard most of the time.
Walkthrough: Setting up ROOT (5 minutes)

ROOT is a robust, complex environment for performing physics analysis, and you can spend a lifetime learning it. Before you start using ROOT on the Nevis particle-physics systems, you have to type the following command:

> module load root

The command `module load root` sets some Unix environment variables and modifies your command and library paths. If you need to remove these changes, use the command `module unload root`.

One of the variables that’s set is $ROOTSYS. This will be helpful to you if you’re following one of the examples in the ROOT Users Guide. For example, if you’re told to find a file in $ROOTSYS/tutorials (on page 79, for example) you’ll be able to do this only after you’ve typed `module load root`.

You have to execute `module load root` once each time you login to Linux and use ROOT. If you wish this command to be automatically executed when you login, you can add it to the `.myprofile` file in your home directory (read the warnings below before you do this).

Warnings:

- Some physics groups work with software frameworks that have their own versions of ROOT built-in; e.g., Athena in ATLAS or LArSoft in MicroBooNE. If you’re working with such a framework, you’ll have a special set-up command to use; you must not use the generic Nevis `module load root`.

- The command `module load root` is only relevant on the Nevis particle-physics computer systems. Other systems will have different ways of setting the environment variables to make ROOT work. If there are other ROOT users on the systems you use, ask them how they set up ROOT.

- Finally, do not put `module load root` in a start-up script if you’re using the notebook server. You’ll get lots of “not found” errors.

---

10 That’s three lifetimes so far.

11 The `module load` UNIX command is part of a package called “environment modules.” Though it’s a standard package, environment modules are not normally included in a UNIX installation. You can read more about this at https://twiki.nevis.columbia.edu/twiki/bin/view/Main/EnvironmentModules.
Walkthrough: Starting ROOT (5 minutes)

You are going to need at least two windows open during this part of the class. One window I'll call your “ROOT command” window; this is where you'll run ROOT. The other is a separate “UNIX command” window. On Unix, you can create a second window with the following command; don't forget the ampersand (&):

```
> xterm &
```

You can also select Open Terminal... from the File menu of a running Terminal application.

I like to use File->Open Tab... instead, but you can use whichever mode you prefer. I suggest you try all the methods to find out which one suits you.

To actually run ROOT, just type:12

```
> root
```

The window in which you type this command will become your ROOT command window. First you'll see a mostly blue ROOT panel appear on your screen. It will disappear, and a brief "Welcome to ROOT" text will appear on your command window.13

If you grow tired of the introductory graphics window, type `root -l` instead of `root` to start the program. That’s “dash-ell,” not “dash-one.”

Click on the ROOT window to select it, if necessary.

You can type .help to see a list of ROOT commands, You'll probably get more information than you can use right now. Try it and see.

For the moment, the most important ROOT line command is the one to quit ROOT. To exit ROOT, type .q. Do this now and then start ROOT again, just to make sure you can do it.

Sometimes ROOT will crash. If it does, it can get into a state for which .q won’t work. Try typing .qqq (three q) if .q doesn’t work; if that still doesn’t work, try five q, then seven q. Unfortunately, if you type ten q, ROOT won’t respond, “You’re welcome.”

OK, that’s a dumb joke; I should leave the humor to xkcd. But the tip about .qqq, .qqqqq, and .qqqqqqq is legitimate. Sometimes I find just typing q or using Ctrl-C also works.

ROOT can function as a calculator. If you want, in ROOT type `2+3` or `sqrt(2)` or whatever. I’m not going to dwell on this aspect of ROOT, but it’s good to know it’s there.14

---

12 I’m starting with “basic” ROOT, which has a command syntax based on C++. For Python users, we’ll explore pyroot later. For these simple examples, the ROOT commands are almost the same in both languages anyway.

13 For ROOT 6.20 and later, the blue introductory ROOT panel no longer appears. If you don’t see it, don’t worry.

14 One of those ROOT quirks that makes you go “uhh…”: If you want to take the sine of 30 degrees you have to use \( \text{sin}(30.\times\text{TMath::Pi()}/180.) \)
Walkthrough: Plotting a function (15 minutes)

Let's plot a simple function. Start ROOT and type the following at the prompt:

```cpp
TF1 f1("func1","sin(x)/x",0,10)
f1.Draw()
```

Note the use of C++ syntax to invoke ROOT commands. ROOT may help you out with context-based colors for the keywords it recognizes. In C++ notation, the first command says: Create an object (“f1”) that is a TF1 (we’ll get to what that is in a moment) with some properties (name, function, low range, high range). The second command tells f1 to draw itself.

When you type in the first command, you may see something like

```plaintext
(TF1 &) Name: func1 Title: sin(x)/x
```

Don’t worry about this. It’s not an error. If you have a keen memory (or you type .help on the ROOT command line), you’ll see that neither TF1 nor any of its methods are listed as commands, nor will you find a detailed description of TF1 in the Users Guide. The only place that the complete ROOT functionality is documented is on the ROOT web site.

Go to the ROOT web site at <http://root.cern.ch/> (did you remember to bookmark this site?), click on References, then on All Classes on the left-hand side, then on TF1; you may want to use the browser menu Edit->Find and search on TF1 to locate that link. Scroll down the page; you’ll see some documentation and examples, the class methods, then method descriptions.

Get to know your way around this web site. You'll come back often.

Also note that when you executed f1.Draw() ROOT created a canvas for you named c1. “Canvas” is ROOT’s term for a window that contains ROOT graphics; everything ROOT draws must be inside a canvas.

(continued on the next page)

---

15 I’m simplifying. ROOT doesn’t use a C++ compiler, but an interpreter called “cling” that duplicates most of the C++ language specification. A prior version of ROOT used an interpreter called CINT; some of the ROOT documentation may still refer to the interpreter by that name.

16 If it’s not an error, what is it? ROOT is printing out the type (TF1 &) and information about the object you’ve just created. When you become more familiar with programming, you’ll see that ROOT is printing out the result of creating the TF1 object, in the same way it would print the result if you typed 2+3.

17 Assuming that ROOT hasn’t reorganized their web site (which they do periodically) since I last reviewed this tutorial, the link to the list of classes is https://root.cern/doc/master/annotated.html and the link to TF1 is https://root.cern/doc/master/classTF1.html.

18 I’m simplifying again. The actual rule is that everything ROOT draws must be inside a “TPad.” Unless you want to add graphics widgets to a window (e.g., buttons and menus), this distinction won’t matter to you.
**Walkthrough: Plotting a function (continued)**

Bring window c1 to the front by left-clicking on it. As you move the mouse over different parts of the drawing (the function, the axes, the graph label, the plot edges) note how the shape of the mouse changes. Right-click the mouse on different parts of the graph and see how the pop-up menu changes.

Position the mouse over the function itself (it will turn into a pointing finger or an arrow). Right-click the mouse and select SetRange. Set the range to xmin=-10, xmax=10, and click OK. Observe how the graph changes.¹⁹

Let's get into a good habit by labeling our axes. Right-click on the x-axis of the plot, select SetTitle, enter "x [radians]", and click OK.

Right-clicking on the title gives you a TCanvas pop-up, not a text pop-up; it’s as if the title wasn’t there. Only if you right-click on the axis can you affect the title. In object-oriented terms, the title and its centering are a property of the axis.

It's a good practice to always label the axes of your plots. Don't forget to include the units.

Do the same thing with the y-axis; call it "sin(x)/x". Select the RotateTitle property of the y-axis and see what happens.

You can zoom in on an axis interactively. Left-click on the number "2" on the x-axis, and drag to the number "4". The graph will expand its view. You can zoom in as much as you like. When you've finished, right-click on the axis and select UnZoom.

---

¹⁹ Did you get something funky instead? You probably right-clicked on the axis, not the function. Quit ROOT and start from the beginning. Question: Why did the graph change in such an unexpected way? For the answer, click on the question mark in the axis SetRange item.
**Walkthrough: Plotting a function (continued)**

You have a lot of control over how this plot is displayed. From the **View** menu, select **Editor**. Play around with this a bit. Click on different parts of the graph; notice how the options automatically change.

Select **View->Toolbar**; among other options, you can see how you can draw more objects on the plot. There's no simple **Undo** command, as there might be in a dedicated graphics program, but you can usually right-click on an object and select **Delete** from the pop-up menu.

If you want to change the color of the function, right-click on the function and select **SetLineAttributes**.

Some of the pop-up menu items have question-mark links in them. While holding down the right button (to keep the menu active), move the mouse to the “?” and press the left button. There’ll be a pause for a few seconds, then you’ll see a description of what the item means. You can also select an option, then click on the **online help** button. Try this for a few options.

Note that the actual helpfulness of the descriptions varies considerably.

There’s also a **Help** menu on the upper-right hand corner of this window. Most ROOT windows have such a menu. Take look at its contents. I usually find that the information is enigmatic, but sometimes there’s something useful.

If you “ruin” your plot, you can always quit ROOT and start it again. We’re not going to work with this plot in the future anyway.

![Image](https://xkcd.com/523/) by Randall Munroe

Alt-text: “There’s also a spike on the Fourier transform at the one-month mark where–”

“You want to stop talking right now.”

If you have a choice, ruin the plot. Don’t let the plot ruin you.
Exercise 1: Detective work (10 minutes)

Duplicate the following plot:20

![3D plot of sin(x)*sin(y)/(x*y)](image)

Figure 6: Some detective work is required to duplicate this plot.

Look at the TF1 command above. If class TF1 will generate a one-dimensional function, what class might generate a two-dimensional function?

If TF1 takes a function name, formula, and x-limits in its constructor, what arguments might a two-dimensional function class use? Where could you check your guess?

With your first try, you probably got a contour plot, not a surface plot. Here’s another hint: you want the give the option "surf1" (with quotes) to the Draw method.

If you’re wondering how to figure out that “surf1” was an valid option to give to Draw( ): Unfortunately, this is not obvious in the current ROOT web site or documentation. Near the top of the TF1 description, it states “TF1 graphics function is via the TH1 and TGraph drawing functions.” If you go to the TH1 class and look at the Draw( ) method, it says “Histograms are drawn via the THistPainter class.” If you go to the THistPainter class, you’ll see all the available Draw( ) options.

It’s a long chain of references, and I didn’t expect you to figure it out on your own. The point is to prepare you for the kind of documentation searches you often have to do to accomplish something in ROOT; for example, the exercises in Parts Six and Seven of this tutorial. Finding the “surf1” option is trivial by comparison!

---

20 The colors don’t have to be the same, since the default colors change in different ROOT versions.
Walkthrough: Working with Histograms (15 minutes)

Histograms are described in Chapter 3 of the ROOT Users Guide. You may want to look over that chapter later to get an idea of what else can be done with histograms other than what I cover in this class.

Let's create a simple histogram:

```cpp
TH1D h1("hist1","Histogram from a gaussian",100,-3,3)
```

Let's think about what these arguments mean for a moment (and also look at the description of TH1D on the ROOT web site). The ROOT name of the histogram is hist1. The title displayed when plotting the histogram is "Histogram from a gaussian". There are 100 bins in the histogram. The limits of the histogram are from -3 to 3.

Question: What is the width of one bin of this histogram? Type the following to see if your answer is the same as ROOT thinks it is:

```cpp
h1.GetBinWidth(0)
```

Note that we have to indicate which bin's width we want (bin 0 in this case), because you can define histograms with varying bin widths.

If you type

```cpp
h1.Draw()
```

right now, you won’t see much. That's because the histogram is empty. Let's randomly generate 10,000 values according to a distribution and fill the histogram with them:

```cpp
h1.FillRandom("gaus",10000)
h1.Draw()
```

The "gaus" function is pre-defined by ROOT (see the TFormula class on the ROOT web site; there's also more on the next page of this tutorial). The default Gaussian distribution has a width of 1 and a mean of zero.

Note the histogram statistics in the top right-hand corner of the plot. Question (for those who've had statistics): Why isn't the mean exactly 0, nor the width exactly 1?

Add another 10,000 events to histogram h1 with the FillRandom method (use up-arrow to enter the command again). Click on the canvas. Does the histogram update immediately, or do you have to type another Draw command?

---

21 For advanced users: Why would you have varying bin widths? Recall the “too many bins” and “too few bins” examples that I showed in the introduction to the class. In physics, it’s common to see event distributions with long “tails.” There are times when it’s a good idea to have small-width bins in regions with large numbers of events, and large bin widths in regions with only a few events. This can result in having roughly the same number of events per bin in the histogram, which helps with fitting to functions as discussed in the next few pages.
Walkthrough: Working with Histograms (continued) [10 minutes]

Let’s put some error bars on the histogram. Select View->Editor, then click on the histogram. From the Error pop-up menu, select Simple. Try clicking on the Simple Drawing box and see how the plot changes.

With these options, the size of the error bars is equal to the square root of the number of events in that histogram bin. Use the up-arrow key in the ROOT command window and execute the FillRandom method a few more times; draw the canvas again. Question: Why do the error bars get smaller? Hint: Look at how the y-axis changes.

You will often want to draw histograms with error bars. For future reference, you could have used the following command instead of the Editor:

```c
[] h1.Draw("e")
```

Let's create a function of our own:

```c
[] TF1 myfunc("myfunc","gaus",0,3)
```

The “gaus” (or gaussian) function is actually \( P_0 e^{-\frac{(x-P_1)}{P_2}} \) where \( P_0, P_1, \) and \( P_2 \) are “parameters” of the function. Let’s set these three parameters to values that we choose, draw the result, and then create a new histogram from our function:

```c
[] myfunc.SetParameters(10.,1.0,0.5)
[] myfunc.Draw()
[] TH1D h2("hist2","Histogram from my function",100,-3,3)
[] h2.FillRandom("myfunc",10000)
[] h2.Draw()
```

Note that we could also set the function's parameters individually:

```c
[] myfunc.SetParameter(1,-1.0)
[] h2.FillRandom("myfunc",10000)
```

What's the difference between SetParameters and SetParameter? If you have any doubts, check the description of class TF1 on the ROOT web site.

---

Figure 7: [https://xkcd.com/904/](https://xkcd.com/904/) by Randall Munroe

Alt-text: “Also, all financial analysis. And, more directly, D&D.”
**Walkthrough: Saving and printing your work (15 minutes)**

By now you've probably noticed the **Save** sub-menu under the **File** menu on the canvas. There are many file formats listed here, but we're only going to use three of them for this tutorial.

Select **Save->canvas-name.C** from one of the canvases in your ROOT session. Let's assume for the moment that you're working with canvas **c1**, so the file “c1.C” is created. In your UNIX window, type

```bash
> less c1.C
```

(If you get complaints about a file not found, the name of the canvas is “see-one,” not “see-ell.”) As you can see, this can be an interesting way to learn more ROOT commands. However, it doesn't record the procedure you went through to create your plots, only the minimal commands necessary to display them.

Next, select **Save->c1.pdf** from the same canvas; we'll print it later.

Finally, select **Save->c1.root** from the same canvas to create the file "c1.root". Quit ROOT with the **.q** command, and start it again.

To re-create your canvas from the ".C" file, use the command

```bash
[l] .x c1.C
```

This is your first experience with a ROOT “macro,” a stored sequence of ROOT commands that you can execute at a later time. One advantage of the “.C method” is that you can edit the macro file, or cut-and-paste useful command sequences into macro files of your own.²²

You can also start ROOT and have it execute the macro all in a single line:

```bash
> root c1.C
```

Quit ROOT and print out your Postscript file with the command

```bash
> lpr -Pbw-research c1.pdf
```

If you want to print directly from the ROOT canvas using **File->Print**, type

```bash
lpr -Pbw-research
```

in the first text box and leave the second one empty.

**Not only is the PDF format useful if you want to print something, but it's usually simple to embed a PDF file in a paper or a presentation. You can't embed a ROOT macro in a Powerpoint document and expect to see its graph!**

---

²² This is still useful if you’re working in pyroot, though you’ll have to do some translation from C++ to Python.
Walkthrough: The ROOT browser (5 minutes)

The ROOT browser is a useful tool, and you may find yourself creating one at every ROOT session.

One way to retrieve the contents of file “c1.root” is to use the ROOT browser. Start up ROOT and create a browser with the command:

```cpp
t[] TBrowser tb
```

In the left-hand pane, scroll to the folder with the same name as your home directory. Scroll through the list of files. You'll notice special icons for any files that end in "\.C" or "\.root". If you double-click on a file that ends in "\.C"; if the Editor tab is in front ROOT will display its contents in the editor window; if the Canvas tab is in front, ROOT will execute its contents. Click on the Canvas tab, then double-click on c1.C to see what happens.

Now double-click on c1.root, then double-click on c1;1.

Don’t see anything? Click on the Canvas 1 tab in the browser window.

What does "c1;1" mean? You're allowed to write more than one object with the same name to a ROOT file (this topic is part of a lesson later in this tutorial). The first object has ";1" put after its name, the second ";2", and so on. You can use this facility to keep many versions of a histogram in a file, and be able to refer back to any previous version.

At this point, saving a canvas as a "\.C" file or as a "\.root" file may look the same to you. But these files can do more than save and re-create canvases. In general, a "\.C" file will contain ROOT commands and functions that you'll write yourself; "\.root" files will contain complex objects such as ntuples.

The ROOT browser has other “gee-whiz” features. For example, if you if select Browser->New HTML, it will open a new tab and display the ROOT class index web page. Feel free to use this built-in web browser if you wish; I sometime find that going through the nested web pages on the ROOT web site via Firefox to be too much of a hassle.

As nifty as the ROOT browser is, for the work that you’ll do this summer you’ll probably reach the limits of what it can do for you, especially if you have to work with large numbers of files, histograms, ntuples, or plots.

Still, it’s nice to know that it’s there, in case (as the name suggests) you want to browse quickly through a couple of ROOT files.

---

23 You may see someone using this command instead:
new TBrowser
The difference is slight, and only matters if you're experienced with C++. (If you are experienced with C++: what is that difference? Hint: see page 46.)

24 The folder hierarchy may be puzzling to you; your home directory will be in /nevis/milne/files/<account>. For now, don’t worry about this. If you’d like to know more, there’s a page on automount at http://www.nevis.columbia.edu/twiki/bin/view/Nevis/Automount.
Walkthrough: Fitting a histogram (15 minutes)

I created a file with a couple of histograms in it for you to play with. Switch to your UNIX window and copy this file into your directory:

    > cp ~seligman/root-class/histogram.root $PWD

Go back to your TB Browser window. (If you've quit ROOT, just start it again and start a new browser.) Click on the folder in the left-hand pane with the same name as your home directory.

Double-click on histogram.root. You can see that I’ve created two histograms with the names hist1 and hist2. Double-click on hist1; you may have to move or switch windows around, or click on the Canvas 1 tab, to see the c1 canvas displayed.

You can guess from the x-axis label that I created this histogram from a gaussian distribution, but what were the parameters? In physics, to answer this question we typically perform a “fit” on the histogram: you assume a functional form that depends on one or more parameters, and then try to find the value of those parameters that make the function best fit the histogram.

Right-click on the histogram and select FitPanel. Under Fit Function, make sure that Predef-1D is selected. Then make sure gaus is selected in the pop-up menu next to it, and Chi-square is selected in the Fit Settings->Method pop-up menu. Click on Fit at the bottom of the panel. You'll see two changes: A function is drawn on top of the histogram, and the fit results are printed on the ROOT command window.

Interpreting fit results takes a bit of practice. Recall that a gaussian has 3 parameters ($P_0$, $P_1$, and $P_2$); these are labeled "Constant", "Mean", and "Sigma" on the fit output. ROOT determined that the best value for the "Mean" was $5.98 \pm 0.03$, and the best value for the "Sigma" was $2.43 \pm 0.02$. Compare this with the Mean and RMS printed in the box on the upper right-hand corner of the histogram. Statistics questions: Why are these values almost the same as the results from the fit? Why aren't they identical?

On the canvas, select Fit Parameters from the Options menu; you'll see the fit parameters displayed on the plot.

As a general rule, whenever you do a fit, you want to show the fit parameters on the plot. They give you some idea if your “theory” (which is often some function) agrees with the “data” (the points on the plot).

(continued on the next page)

---

25 If you’re going through this class and you’re not logged onto a system on the Nevis Linux cluster, you’ll have to get all the files from my web site: http://www.nevis.columbia.edu/~seligman/root-class/files/

If you want to get all the files from that directory at once, you can use this UNIX command:


You may have to install the wget command on your system, since it’s often not installed by default.

Be aware that in that directory there are a lot of work files I created to test things. There's more in there than just the files I reference in my tutorials.
Figure 8: The resulting plot should look something like this.

Figure 9: It will look nothing like this. This would be a poor fit for your function.

http://xkcd.com/815 by Randall Munroe
Alt-text: “As the CoKF approaches 0, productivity goes negative as you pull OTHER people into chair-spinning contests.”
**Walkthrough: Fitting a histogram (continued)**

As a check, click on **landau** (which vaguely resembles the plot in Figure 9) on the FitPanel's **Fit Function** pop-up menu and click on **Fit** again; then try **expo** and fit again.

You may have to click on the **Fit** button more than once for the button to “pick up” the click. It looks like of these three choices (gaussian, landau, exponential), the gaussian is the best functional form for this histogram. Take a look at the "Chi2 / ndf" value in the statistics box on the histogram ("Chi2 / ndf" is pronounced "kie-squared per [number of] degrees of freedom"). Do the fits again and observe how this number changes. Typically, you know you have a good fit if this ratio is about 1.

The FitPanel is good for gaussian distributions and other simple fits. But for fitting large numbers of histograms (as you’d do in Parts Six and Seven) or more complex functions, you want to learn the ROOT commands.

To fit hist1 to a gaussian, type the following command:  
```c++
[] hist1->Fit("gaus")
```
This does the same thing as using the FitPanel. You can close the FitPanel; we won’t be using it anymore.

Go back to the browser window and double-click on **hist2**.

You’ve probably already guessed by reading the x-axis label that I created this histogram from the sum of two gaussian distributions. We’re going to fit this histogram by defining a custom function of our own.

Define a user function with the following command:
```c++
[] TF1 func("mydoublegaus","gaus(0)+gaus(3)")
```
Note that the internal ROOT name of the function is "mydoublegaus", but the name of the TF1 object is func.

What does "gaus(0)+gaus(3)" mean? You already know that the "gaus" function uses three parameters. "gaus(0)" means to use the gaussian distribution starting with parameter 0; "gaus(3)" means to use the gaussian distribution starting with parameter 3. This means our user function has six parameters: $P_0$, $P_1$, and $P_2$ are the "constant", "mean", and "sigma" of the first gaussian, and $P_3$, $P_4$, and $P_5$ are the "constant", "mean", and "sigma" of the second gaussian.

(continued on the next page)

---

26 What’s the deal with the arrow “->” instead of the period? It’s because when you read in a histogram from a file, you get a pointer instead of an object. This only matters in C++, not in Python. See page 46 for more information.
Walkthrough: Fitting a histogram (continued)

Let's set the values of $P_0, P_1, P_2, P_3, P_4,$ and $P_5,$ and fit the histogram.

```c
func.SetParameters(5.,5.,1.,1.,10.,1.)
hist2->Fit("mydoublegaus")
```

It’s not a very good fit, is it? This is because I deliberately picked a poor set of starting values. Let’s try a better set:

```c
func.SetParameters(5.,2.,1.,1.,10.,1.)
hist2->Fit("mydoublegaus")
```

These simple fit examples may leave you with the impression that all histograms in physics are fit with gaussian distributions. Nothing could be further from the truth. I’m using gaussians in this class because they have properties (mean and width) that you can determine by eye.

Chapter 5 of the ROOT Users Guide has a lot more information on fitting histograms, and a more realistic example.

If you want to see how I created the file histogram.root, go to the UNIX window and type:

```
> less ~seligman/root-class/CreateHist.C
```

In general, for fitting histograms in a real analysis, you’ll have to define your own functions and fit to them directly, with commands like:

```c
TF1 func("myFunction","<...some parameterized TFormula...>")
func.SetParameters(...some values...)
myHistogram->Fit("myFunction")
```

For a simple gaussian fit to a single histogram, you can always go back to using the FitPanel.

---

27 It may help to view the PDF file with this tutorial and cut-and-paste the commands from here into your ROOT window. You can find this file at [http://www.nevis.columbia.edu/~seligman/root-class/](http://www.nevis.columbia.edu/~seligman/root-class/).

**Warning:** For now, don’t fall into the trap of cutting-and-pasting every command from this tutorial into ROOT. Save it for the more complicated commands like SetParameters or file names like `~seligman/root-class/AnalyzeVariables.C`. You want to get the “feel” for issuing commands interactively (perhaps with the tricks described on page 8), and that won’t happen if you just type Ctrl-C/click/Ctrl-V over and over again.

When we get to Part Two, you’ll start cutting-and-pasting commands into notebooks on a regular basis.
Figure 10: Some possibilities for fitting plots using ROOT.
https://xkcd.com/2048/ by Randall Munroe
Alt-text: “Cauchy-Lorentz: ‘Something alarmingly mathematical is happening, and you should probably pause to Google my name and check what field I originally worked in.’”
**Walkthrough: Saving your work, part 2 (15 minutes)**

So now you’ve got a histogram fitted to a complicated function. You can use **Save as c1.root**, quit ROOT, restart it, then load canvas "c1;1" from the file. You’d get your histogram back with the function superimposed... but it’s not obvious where the function is or how to access it now.

What if you want to save your work in the same file as the histograms you just read in? You can do it, but not by using the ROOT browser. The browser will open .root files in read-only mode. To be able to modify a file, you have to open it with ROOT commands.

Try the following: Quit ROOT (note that you can select **Quit ROOT** from the **Browser** menu of the browser or the **File** menu of the canvas). Start ROOT again, then modify "histogram.root" with the following commands:

```cpp
[] TFile file1("histogram.root","UPDATE")
It is the "UPDATE" option that will allow you to write new objects to "histogram.root".
[] hist2->Draw()
For the following two commands, hit the up-arrow key until you see them again.
[] TF1 func("user","gaus(0)+gaus(3)")
[] func.SetParameters(5.,2.,1.,1.,10.,1.)
[] hist2->Fit("user")
Now you can do what you couldn't before: save objects into the ROOT file:
[] hist2->Write()
[] func.Write()
Close the file to make sure you save your changes:
[] file1.Close()
```

Quit ROOT, start it again, and use the ROOT browser to open "histogram.root". You’ll see a couple of new objects: "hist2;2" and "user;1". Double-click on each of them to see what you’ve saved.

You wrote the function with `func.Write()`, but you saw `user;1` in the file. Do you see why? It has to do with the name you give to objects in your programming environment, versus the internal name that you give to ROOT. There’s more about this on page 43. I wanted to point it out so that you were aware that, though they seem closely connected at times, C++ and ROOT are two different entities.

Chapter 11 of the ROOT Users Guide has more information on using ROOT files.

---

28 *In case you care:* ROOT stores your ROOT commands in the file “.root-hist” in your home directory; that’s where it gets the lines you see with the up-arrow key. Similarly, the UNIX shell stores the last 5000 commands you’ve typed in .sh-history in your home directory.

29 I’ve seen some ROOT documentation that suggests that closing the file is optional, since ROOT usually closes the file for you when you quit the program. However, I’ve also seen many ROOT files made unreadable because they weren’t closed properly. I suggest you always explicitly close any file you open!
**Walkthrough: Variables in ROOT NTuples/Trees (10 minutes)**

I’ve created a sample ROOT ntuple for you. Quit ROOT. Copy the example file:

```bash
> cp ~seligman/root-class/experiment.root $PWD
```

Start ROOT again. Start a new browser with the command

```
[] TBrowser b
```

Click on the folder in the left-hand pane with the same name as your home directory. Double-click on `experiment.root`. There’s just one object inside: `tree1`, a ROOT TTree (or ntuple) with 100,000 simulated physics events.

There’s no real physics associated with the contents of this ntuple. I created it to illustrate ROOT concepts, not to demonstrate physics with a real detector.

Right-click on the `tree1` icon, and select **Scan**. You'll be presented with a dialog box; just hit **OK** for now. Select your ROOT window, even though the dialog box didn't go away. At first you'll notice that it's a lot of numbers. Take a look at near the top of the screen; you should see the names of the variables in this ROOT Tree.

You can hit Enter to see more numbers, but you probably won’t learn much. Hit **q** to finish the scan. You may have to hit Enter a couple of times to see the ROOT prompt again.

In this simple example, a particle is traveling in a positive direction along the z-axis with energy `ebeam`. It hits a target at z=0, and travels a distance `zv` before it is deflected by the material of the target. The particle’s new trajectory is represented by `px`, `py`, and `pz`, the final momenta in the x-, y-, and z-directions respectively. The variable `chi2` ($\chi^2$) represents a confidence level in the measurement of the particle’s momentum after deflection. The variable "event" is just the event number (0 for the first event, 1 for the second event, 2 for the third event... 99999 for the 100,000th event).

![Diagram](image.png)

*Figure 11: Sketch of the experiment and variables.*

(continued on next page)
Walkthrough: Variables in ROOT NTuples/Trees (continued)

Did you notice what's missing from the above description? Answer: units. I didn't tell you whether \( zv \) is in millimeters, centimeters, inches, yards, etc. Such information is not usually stored inside an ntuple; you have to find out what it is and include the units in the labels of the plots you create.\(^{30}\) For this example, assume that \( zv \) is in centimeters \((cm)\), and all energies and momenta are in \( GeV \).

There’s something else that’s missing, but you wouldn’t have noticed it unless you’ve performed a scientific analysis before: time. Any real experiment would have several variables relating to time (the time of the event, the time that the particle interacted in the detector, etc.) I haven’t included any time-related variables in this ntuple, with the possible exception of the event number, mainly because they wouldn’t illustrate what I want to teach you in this tutorial.

---

\(^{30}\) **Advanced note:** There is a way of storing comments about the contents of a ROOT tree, which can include information such as units. However, you can't do this with ntuples; you have to create a C++ class that contains your information in the form of comments and use a ROOT “dictionary” to include the additional information. This is outside the scope of what you'll be asked to do this summer. If you're interested in the concept, it's described in Chapter 15 of the ROOT User's Guide. There’s an example in Part Seven of this tutorial.
Using the Treeviewer

Right-click the tree1 icon again and select StartViewer.

You're looking at the TreeViewer, a tool for making plots from ntuples interactively. The TreeViewer is handy for quick studies of ntuples, but it’s almost certainly not enough to get you through the work you’ll have to do this summer. Any serious analysis work will involve editing ROOT macros and writing C++ code or Python scripts.

Still, there are times when a simple tool can be useful. Let’s use the TreeViewer to examine the tree1 ntuple. Once you have an idea of what’s inside tree1, you’ll be ready to start writing programs to analyze it.

You can figure out how to use the TreeViewer on your own; the Help menu in the right-hand corner of the TreeViewer panel is genuinely useful. Here’s a quick guide to get you started.

In the second column of the large pane in the window, you’ll see the variables in the ntuple; they all have a “leaf” icon next to them. Double-click on one of them and look the resulting histogram. Double-click on a few more variables and see how the histogram changes.

Figure 13: This is what I see when I run TreeViewer on my Macintosh.

---

31 If you feel that this course has been too easy so far, you can skip the TreeViewer. It’s trivial to learn on your own if you want to. If you already know about cuts and scatterplots, skip ahead to page 34.

32 The name of the package is ROOT, an ntuple is a type of Tree, and the individual variables are “leaves” on the Tree. ROOT has “branches” as well: if you remember that spreadsheet model I showed you during the lecture, branches correspond to entire columns.
Correlating variables: scatterplots (10 minutes)

Left-click on a variable and hold the mouse down. Drag the variable next to the blue curly X in the first column, over the word empty, and let go of the button. Now select a different variable and drag it over next to the curly Y. Click on the scatterplot icon in the lower left-hand corner of the TreeViewer (it’s next to a button labeled SPIDER\(^3^3\)).

This is a scatterplot, a handy way of observing the correlations between two variables. Be careful: it’s easy to fall into the trap of thinking that each (x,y) point on a scatterplot represents two values in your n-tuple. In fact, the scatterplot is a grid and each square in the grid is randomly populated with a density of dots that’s proportional to the number of values in that grid.

Drag different pairs of variables to the X and Y boxes and look at the scatterplots. Do you see any correlations between the variables?

If you just see a shapeless blob on the scatterplot, the variables are likely to be uncorrelated; for example, plot px versus py. If you see a pattern, there may be a correlation; for example, plot pz versus zv. It appears that the higher pz is, the lower zv is. Perhaps the particle loses energy before it is deflected in the target.

![Figure 14: This is what I see when I make a scatterplot of zv versus ebeam. The variables look uncorrelated to me, subject to the restriction that we can’t have zv < 0.](image)

\(^3^3\) Go ahead and click on the SPIDER button if you want. A spider (or radar) chart is a way of displaying multivariant data in a two-dimensional graph. For more information, see https://www.fusioncharts.com/resources/chart-primers/radar-chart

I’ve never seen spider charts used in physics, except when I looked up the definition for this tutorial. By the way, if you clicked that link, you just looked up spider charts on the web.
New variables: expressions (10 minutes)

There are other quantities that we may be interested in apart from the ones already present in the ntuple. One such quantity is \( p_T \), which is defined by:

\[
p_T = \sqrt{p_x^2 + p_y^2}
\]

This is the transverse momentum of the particle, that is, the component of the particle’s momentum that’s perpendicular to the \( z \)-axis.

You can use TreeViewer to create expressions that are functions of the variables in the tree. Double-click on one the \( E() \) icons that has the word –empty– next to it. In the dialog box, type \( \sqrt{p_x^2 + p_y^2} \) in the box under **Expression**, and type \( \sim pt \) in the box under **Alias**. Then click on **Done**. Now double-click on the word \( \sim pt \) in the TreeViewer.

When you’re typing in the expression, you don’t have to type the name of any variable in the tree. You can just click on the name in the TreeViewer.

The quantity \( \theta \), or the angle that the beam makes with the \( z \)-axis, is calculated by:

\[
\theta = \arctan \left( \frac{p_T}{p_z} \right)
\]

The units are radians. Let’s create a new expression to calculate \( \theta \). Double-click on a different \( E() \) icon with –empty– next to it. Type \( \text{atan2}(\sim pt, \sim pz) \) under **Expression**, and \( \sim \theta \) under **Alias**. Click **Done**, then double-click on \( \sim \theta \).

After an expression is no longer empty, you can’t double-click on it to edit it; that will just cause the expression to be plotted. To edit an existing expression, right-click on it and select **EditExpression**.

Note that you can have expressions within expressions (such as \( \sim pt \) in the definition of \( \sim \theta \)). All expressions that you create must have names that begin with a tilde (~), and the expression editor will enforce this. A common error is to forget the tilde when you’re typing an expression; that’s the reason why it can be a good idea to insert a variable or an alias into an expression by clicking on it in the TreeViewer.

---

34 That first character is a tilde (~), not a dash.

35 The reason to use \( \text{atan2}(y, x) \) instead of just \( \text{atan}(y/x) \) is that the \( \text{atan2} \) function correctly handles the case when \( x=0 \).
Restricting values: cuts (10 minutes)

Let’s create a "cut" (a limit on the range of a variable to be plotted). Edit another empty expression and give it the formula \( zv < 20 \) and the alias \( zcut \).

Note how the icon changes in the TreeViewer. ROOT recognizes that you’ve typed a logical expression instead of a calculation.

Drag \( \sim zcut \) to the scissor icon. Double−click on \( zv \) to plot it. Double−click on some of the other variables and look at both the histogram title and the \textbf{Nent} in the statistics box of the histograms; the \( z \)-cut affects all the plots, not just the plot of \( zv \).

Double−click on the scissor icon to turn off the cut; note the change in the scissor icon. Double−click on the icon again to turn the cut back on.

Now edit \( \sim zcut \) by right−clicking on it and selecting \textbf{EditExpression}. Edit the expression to read \( zv<20 \ &\ & zv>10 \) and click \textbf{Done}. Plot \( zv \). Has the cut changed? Now drag \( \sim zcut \) to the scissors and plot \( zv \) again.

![Figure 15: This is what I see when I make a plot of theta with the cut "zv<20 & zv>10".](image)

(continued on next page)

---

36 For those who know what a “weighted histogram” means: A “cut” is actually a weight ROOT applies when filling a histogram; a logical expression has the value 1 if true and the value 0 if false. If you want to fill a histogram with weighted values, use an expression for the cut that corresponds to the weight.

For example: a cut of \( 1/e \) will fill a histogram with each event weighted by \( 1/e \); a cut of \( (1/e)*(\sqrt{z}>3.2) \) will fill a histogram with events weighted by \( 1/e \), for those events with \( \sqrt{z} \) greater than 3.2.
Restricting values: cuts (continued) (optional)

If you wanted to display this plot in a talk, you’d have to label both axes (which you learned to do on page 13) and do something about that title. It’s not clear how to fix the title of a plot from TreeViewer; if you right-click on it you see that it’s a \texttt{TPaveText} with a number of options that don’t seem to do what you want.

I figured this out by saving the plot as \texttt{c1.C}, examining that file, and looking up \texttt{TPaveText} on the ROOT web site. The simplest way to edit the title is right-click on it, select \texttt{Clear}, then select \texttt{InsertText} and type in your new title.

![Comic strip](http://xkcd.com/167)

That’s why we climb (analyze) TTrees: the future is an adventure, and you don’t know what you’ll find.

Alt-text: “Why can’t you have normal existential angst like all the other boys?”

And perhaps the first speaker is wrong in other ways.
Part Two – The Notebook Server

If you’re familiar with Jupyter or IPython, you can skim or skip this part.

Now I’m going to introduce a different software development tool, the notebook. It’s independent of ROOT, but it can be handy for creating ROOT programs.

Starting with Jupyter (5 minutes)

In any web browser (laptop, desktop, phone), go to https://notebook.nevis.columbia.edu. You’ll be prompted for your Nevis Linux cluster account name and password.

When you visit notebook for the first time, you'll see your home directory. You can perform some elementary file operations from this screen: check the box next to a filename, and you’ll see an option near the top of the screen to rename or delete the file. The Upload button near the top left allows you to copy files from the computer you're using to the Nevis cluster.

The fun part is in the pop-up menu you get from clicking the “New” button near the top left:

- **Text File** will give you a basic text editor. You will also get a text editor if you click on a text file on the home directory page. The Edit menu within the editor page will let you select which text editor you use; from page 8 you know my favorite editor is Emacs, but you can use whatever you wish.

- **Folder** lets you create a new sub-directory.

- **Terminal** will give you access to a limited (but still useful) terminal emulator.

- And then we have the notebook kernels…

  In Jupyter, a “kernel” is an environment for interpreting commands. I installed lots of kernels on the notebook server for users to explore, but for this tutorial there are only two of interest: “Python 3” (which includes an interface to ROOT) and “ROOT C++”.

![Figure 17](https://xkcd.com/1202/) by Randall Munroe

---

37 Take care: it’s “https”, not just “http”.

38 If you don’t have an active account at Nevis, then you won’t be able to login. You’ll have to install Jupyter on your own system (see page 88) or proceed without it; go on to the next section.

39 For details, see https://twiki.nevis.columbia.edu/twiki/bin/view/Main/JupyterTerminal.

40 For a description of each of the kernels, see https://twiki.nevis.columbia.edu/twiki/bin/view/Main/IPython.

41 Check with your working group. They may still use Python 2.
Your first notebook (10 minutes)

From the **New** menu, select Python 3. You’ll see your first empty cell, labeled **In [1]**. At the top of the page, you’ll see that the name of the notebook is **Untitled**. The first thing you should do when creating a new notebook is to give it a new name. Go to the **File** menu within the Jupyter page and select **Rename...** Pick any name you wish, such as **pythontest**.

After you’ve renamed the notebook, go back to the Jupyter Home window. You’ll see the notebook file with the extension .ipynb.

Go back to the notebook window. Under the **Help** menu, take the **User Interface Tour** (it’s about a minute long). Note the **Keyboard Shortcuts**.

Cut-and-paste the following into that first cell.

```python
from ROOT import TH1D, TCanvas
my_canvas = TCanvas("mycanvas","canvas title",800,600)
example = TH1D("example","example histogram",100,-3,3)
example.FillRandom("gaus",10000)
exomple.Draw("E")
my_canvas.Draw()
```

This code is in Python, but after going through Part One of this tutorial you can probably figure out what most of these lines are supposed to do.

To "execute" the contents of a given cell, hit **SHIFT-ENTER** with your cursor in that cell. Do that now.

Oops! There’s an error. Fix the error in the cell and hit **SHIFT-ENTER** again.

Assuming there have been no mistakes, you should see a histogram embedded in the web page.

There are also a couple of warning messages:

```
Warning in <TCanvas::Constructor>: Deleting canvas with same name: mycanvas
Warning in <TROOT::Append>: Replacing existing TH1: example (Potential memory leak).
```

Let’s think about what those messages mean. When you execute lines in a cell, your environment doesn’t “start fresh”; everything you defined before is still there. ROOT is warning you that the TCanvas and the histogram are being overridden.

In Python, you can usually ignore these warnings.

---

42 You don’t **have** to do this. But if you don’t, your home directory will soon be littered with notebooks named Untitled.ipynb, Untitled1.ipynb, Untitled2.ipynb, etc., and you won’t know what’s in any of them.

43 There are more Jupyter hints at [https://www.dataquest.io/blog/jupyter-notebook-tips-tricks-shortcuts/](https://www.dataquest.io/blog/jupyter-notebook-tips-tricks-shortcuts/). Some of those tips won’t work on the Nevis systems; e.g., you can’t install new packages on the Nevis notebook server. The last tip, on different ways to share notebooks, will be helpful to those who work with folks who don’t use Jupyter.

44 You can type it in manually if you want, but (a) that’s a lot of typing, and (b) you have to make sure you get each character correct for the sake of this example.
Click in the next cell and cut-and-paste this line, then hit SHIFT-ENTER:

```python
exampleFit = example.Fit("gaus")
```

Note that this next cell recognizes the histogram object you defined in the previous cell. This gives you some idea of one feature of notebooks: You can fiddle with something in a given cell until it does what you want, then move on to the next phase of your task that depends on the previous cell.

Wait a moment... We just added a fit to the histogram, but the plot didn’t change. Maybe we have to plot it again.

Enter this line after the one you just pasted, or into a subsequent cell, and hit SHIFT-ENTER:

```python
example.Draw()
```

No new plot, and the plot above it still didn’t change. What’s wrong? Nothing. Jupyter runs in a web browser, and browsers behave differently than X-Windows (the underlying graphics protocol of UNIX). You may have noticed that, unlike the ROOT plots in Part One, the shape of the cursor doesn’t change as you move it over the plot, and right-clicking on it brings up a browser menu, not a ROOT one. If you right-click on the plot and select **View Image**, you’ll see that the plot is not a dynamic object, but a static `.png` file.45

How do we get a plot? You probably guessed the answer from what I had in the first cell. Paste the following line after that last `Draw()` command, or in a new cell:

```python
my_canvas.Draw()
```

Finally, you see the histogram with the fit superimposed.

Remember page 12: ROOT plots everything in a canvas. In Jupyter, a TCanvas is not automatically drawn when its underlying plot updates. You have to explicitly draw the TCanvas yourself. That’s why the first example contains the lines:

```python
my_canvas = TCanvas("mycanvas","canvas title",800,600)
# ... stuff ...
my_canvas.Draw()
```

I had to define the TCanvas that would be used as the “target” of any `Draw` commands, then Draw that TCanvas in order for the plot to be displayed.46

---

45 "PNG" stands for Portable Network Graphics. It’s a standardized format for uncompressed images to be sent over the web. Jupyter uses that format instead of GIF because the GIF algorithm is patented.

46 Since we haven’t had to explicitly define our canvases before, I should mention: the canvas name and title are usually not important; the name only matters if you were to write the canvas to a file, and the canvas title is rarely displayed (as opposed to the histogram title, which appears at the top of the plot).

What matters is the size of the canvas. Here, I used 800 pixels wide and 600 pixels tall, which is the size of our old friend `c1` that’s automatically defined if you don’t define a canvas yourself.

I could have defined the canvas using only defaults with

```python
my_canvas = TCanvas()
```

but I thought that might be even more confusing to see for the first time.
Magic commands (5 minutes)

In Jupyter, “magic” refers to additional commands added by Jupyter to the kernel environment that aren’t normally part of that kernel’s language. I’m going to start with a slightly exotic magic command because I think you’ll find it useful.

In a new cell in the Python notebook we worked with above, execute this command:

```python
%jsroot on
```

As a general rule, magic commands begin with the percent sign “%”.

Draw the canvas again:

```python
my_canvas.Draw()
```

Move the cursor over the new plot.

Ah, that’s more like it! The plot is not interactive in the same way as in X-Windows ROOT, but you can get a lot done. Play around a bit, looking at tooltips and right-clicking. Note the faint icons below the lower left-hand corner of the plot.

If you execute `%lsmagic` you’ll see a list of available magic commands. There’s probably more here than you can absorb right now. Here are examples of the magic commands I find to be the most useful:

```bash
%mkdir subdirectory
%cp ~seligman/root-class/jsroot-test.ipynb subdirectory
%ls subdirectory
%less c1.C
%man root
%cd subdirectory
```

The above commands are “line magics,” which are executed line-by-line within a cell. There are also “cell magics” that affect the contents of the entire cell in which they appear; they must appear as the first line in a cell. They begin with a double “%”. Examples:

- `%%writefile <filename>` (write the cell to file `<filename>`);
- `%%timeit` (execute the cell many times and determine the average execution time);
- `%%sh` (execute the cell as a UNIX shell script).

---

47 No, nothing to do with Doctor Strange or Harry Potter, though you may find yourself muttering “Avada Kedavra” as you work with ROOT.

48 Note that the `%jsroot` magic command is only available in Python-based notebooks after you’ve executed `import ROOT` or `from ROOT import...` In ROOT C++ notebooks it’s built-in.

“JSROOT” is short for “Javascript ROOT”; it’s an evolving project to bring more interactivity of ROOT graphics into web browsers. For more information, see https://github.com/root-project/jsroot/blob/master/docs/JSROOT.md.

49 Well… not really. There’s an option (`%automagic on | off`) that allows you to omit the leading %`. In this tutorial I’ll always include the % prefix to make it clear when a command is “magic”.

50 You can find a description of magic commands here: https://ipython.org/ipython-doc/3/interactive/magics.html. Ignore the “old version” warning, especially if you’re using Python 2 with ROOT.
**Markdown cells (5 minutes)**

One of the hardest habits to get into is documenting your work. Jupyter makes it easy. Click in an empty cell. Go to the pop-up menu near the top of the page that reads **Code**. Select **Markdown** from that menu. Now you can type plain text in that cell; e.g., “The following code sums all the histograms in the analysis.” When you're done, hit SHIFT-ENTER to see the formatted result.

You can also include Markdown, HTML, and LaTeX commands to format the text. Here are some examples: declare a cell to be Markdown, paste one of the following paragraphs into the cell, and hit SHIFT-ENTER:

**Markdown**

```markdown
# 2019 Analysis Project
*Energy*, **time**, and `momentum` are all variables in this ntuple.
```

**HTML**

```html
<h1>2019 Analysis Project</h1>
<p><i>Energy</i>, <b>time</b>, and <tt>momentum</tt>.</p>
<p>The following code reads in an ntuple.</p>
```

**LaTeX**

```latex
\begin{align}
\nabla \times \mathbf{B} & - \frac{1}{c}, \frac{\partial \mathbf{E}}{\partial t} = \frac{\partial \mathbf{j}}{\partial t}
\n\nabla \cdot \mathbf{E} & = 4 \pi \rho
\n\nabla \times \mathbf{E} & + \frac{1}{c}, \frac{\partial \mathbf{B}}{\partial t} = 0
\end{align}
```

Can you mix all of them in a single Markdown cell? Give it a try!

---

51 Markdown is a simple text-layout layout that emphasizes readability over the methods described in the next two footnotes. There are a lot of tutorials on the web; here’s one: [https://help.github.com/articles/basic-writing-and-formatting-syntax/](https://help.github.com/articles/basic-writing-and-formatting-syntax/).

52 HTML (“HyperText Markup Language”) is the standard language for formatting content in web browsers. If you’ve never seen it before, it’s because you’ve used some program that formats web pages for you into HTML (Markdown is one such program). My favorite HTML tutorial is at [https://www.w3schools.com/html/](https://www.w3schools.com/html/).

If you want a couple of xkcd cartoons on HTML: [https://xkcd.com/1341/](https://xkcd.com/1341/) and [https://xkcd.com/1144/](https://xkcd.com/1144/).

53 LaTeX is a document-preparation package that’s often used in research. If you write a paper for publication this summer, you are going to use LaTeX; physics publications don’t accept articles in MS-Office format. Don’t worry about learning LaTeX. No one writes a LaTeX document from scratch; they get one from someone and learn by example. It’s much easier than learning ROOT. For some Jupyter-related examples, see [http://jupyter-notebook.readthedocs.io/en/latest/examples/Notebook/Typesetting%20Equations.html](http://jupyter-notebook.readthedocs.io/en/latest/examples/Notebook/Typesetting%20Equations.html).

You can spend a lifetime learning LaTeX, but no one ever has.
The ROOT C++ kernel (5 minutes)

In Part One, all of the practice ROOT code used C++ syntax. Yet I switched to Python when I introduced Jupyter. Now you’ll learn why.

Start a ROOT C++ notebook (either from your Jupyter home page, or from the File menu of your existing notebook). Rename it to cplusplus or whatever you want. Paste the following into a cell and execute it:

```cpp
TH1D example("example","example histogram",100,-3,3);
example.FillRandom("gaus",10000);
example.Draw();
```

You won’t see anything, but after the explanation on page 34 you know why: you have to draw the canvas. The warning message says it drew the plot on TCanvas c1, so add the following line to the end of the above cell and hit SHIFT-ENTER:

```cpp
c1.Draw();
```

Uh-oh. It’s not just warning you that you’re creating a new histogram with the same name. ROOT’s C++ interpreter is treating it as an error and won’t let you continue.

This is a general issue of Python vs. C++: Python is more forgiving. If you want to execute that cell, you’ll have to restart ROOT. Fortunately, there’s an easy way to do that.

Go to the Kernel menu on the page and select Restart. It will warn you that you’re about lose all your variables, which in this case is exactly what you want. Click in the cell with your code and hit SHIFT-ENTER.

I’m being sneaky, aren’t I? I knew `c1.Draw()` would not work. The error message tells you why: the automatically created c1 is a pointer, and requires the -> symbol.

Edit the “.” to the pointer symbol “->” and hit SHIFT-ENTER. You forgot to restart the kernel again, didn’t you? Restart the kernel then hit SHIFT-ENTER in the cell.

If you think about it for a second, I could have given you a more complete example, the same way I did for the Python notebook:

```cpp
TCanvas my_canvas();
TH1D example("example","example histogram",100,-3,3);
example.FillRandom("gaus",10000);
example.Draw();
my_canvas.Draw();
```

I presented it this way to make a couple of points. First, I wanted to show you how to restart a kernel within a notebook, which you may want to do even in Python.\(^54\)

Second, I wanted you to learn that if you’re working with C++ in ROOT, you’ll have to be aware when you’re redefining objects that ROOT thinks you’ve created before. You can work with ROOT C++ in Jupyter\(^55\) but you have to be mindful of your environment.

---

\(^54\) If you looked at the keyboard shortcuts, you know another way: Hit ESC to get into Command Mode, then hold down the 0 (zero) key.

\(^55\) There are lots of examples at [https://swan.web.cern.ch/content/basic-examples](https://swan.web.cern.ch/content/basic-examples).
Decisions

If you’ve already made up your mind about the questions posed in the section headers, you can skip or skim this section.

C++ or Python?

Up until this point, the commands for ROOT/C++ and Python/ROOT were nearly identical.\(^{56}\) I presented them in the context of using cling, ROOT’s C++ environment.

From this point forward, using ROOT/C++ is different from using Python with ROOT extensions. You have to decide: in which language do you want to use ROOT? My initial advice is to ask your supervisor. Their response, in ascending order of likelihood, will be:

- A clear decision (C++ or Python).
- “I don’t know. Which do you feel like learning?”
- “I have no idea what you’re talking about.”

If it’s up to you, this may help you decide:\(^{57}\)

In favor of Python:

- Learning Python is easier and faster than learning C++.
- Python can be more appropriate for “quick-and-dirty” analysis efforts, if that’s the kind of work you’ll be doing this summer.

In favor of C++:

- All of the ROOT documentation, Parts Six and Seven of this tutorial, and most of the tutorials included with ROOT (see page 79) are in C++.
- If you’re going to be working with your experiment’s analysis framework, it will almost certainly involve working in C++.
- C++ code, when compiled, is faster than Python (see page 59).\(^{58}\)

---

\(^{56}\) See page 53 for the differences when using Python versus ROOT/C++.

\(^{57}\) Here are the areas in which neither has a clear advantage: Both C++ and Python are used worldwide, so knowing either one is useful. Python’s interactive development is usually cited as an advantage over C++, but ROOT offers the interactive C++ interpreter, cling. Both languages have substantive numerical computing libraries (e.g., SciPy in Python, GSL in C++). For raw computing power, FORTRAN is the best, but it’s no longer in style.

\(^{58}\) There are various tricks for making Python run faster; e.g., the %pypy cell magic, the Cython extension, list comprehensions, clever use of NumPy. You’ll learn about them if you choose to become a Python expert.
**Command-line or notebook?**

Once you’ve decided on the language, you next have to decide on your programming environment: the command line as in Part One, or the notebook as in Part Two.

**In favor of notebooks**

- They facilitate rapid code development. You fiddle inside a cell, hit SHIFT-ENTER to execute it, get it to do what you want. Then you move to the next cell.
- Documentation is easy, as shown on page 37.
- Notebooks are easy to share. For example, a colleague of yours can copy one of your notebooks to their own area to look at it:
  
  ```bash
  %cp ~/jsmith/energy-calibration/myanalysis.ipynb jsmith-analysis.ipynb
  ```
- The interface to a notebook is through a web browser. You don’t need ssh or an X-Windows emulator.

**Against notebooks**

- They’re relatively new in software development. It’s possible your supervisor has never heard of them. If you say you’ve got a .png plot in a Jupyter notebook, they’ll reply “You’ve got a what in a where?”
- The `%jsroot on` magic command does not enable every X-Window feature available from within the ROOT command line. There’s no TBrowser, TreeViewer, or FitPanel. You can’t add new elements to a plot and then save the ROOT commands so you can examine how to use them in a .C file.\(^{59}\)
- As you saw in the examples above, your canvases are not automatically drawn or updated for you. You must explicitly issue Draw() commands for your canvases.

**Issues with our notebook server**

Most of these points involve technical sysadmin issues. You may want to skip them, and come back later if you have a notebook problem.

- The Nevis particle-physics JupyterHub notebook server is not something you find at most institutions, at least not for now. Only the REU students and the particle-physics groups have access to it. Your astrophysics or RARAF colleagues won’t be able to view your notebooks. You can install Jupyter on your laptop, but that won’t help anyone else see your work.
- You can develop software in notebooks, but you can’t run multi-threaded or multi-

---

\(^{59}\) Oops, I just lied to you. If you’ve drawn something to `my_canvas`, you can write its associated ROOT commands to a file with

```c
my_canvas.SaveSource("filename.C");
```

where `filename.C` can be any name you want. Don’t forget to use `->` if your canvas variable is a C++ pointer instead of an object!
hour jobs with them on our notebook server.\textsuperscript{60}

- Some physics software is a “chimera”, a blend of software compiled in two languages. For example, the Neutrino Deep Learning group uses Python to call pre-compiled C++ routines. Our notebook server can’t run software that’s been compiled on another machine.\textsuperscript{61}

- As you get more familiar with the UNIX shell, you may start making changes to your standard shell setup. You do this by editing special shell initialization files such as .profile.\textsuperscript{62} If you add new variables to your environment, these variables are available in our notebook server as well.\textsuperscript{63}

However, if you modify certain variables such as $LD_LIBRARY_PATH or run customization programs (such as module load root) in your default initialization, it can affect the execution of the notebook server. The typical symptoms are a notebook kernel that refuses to start or you get library load errors.

You can get around many of these issues by running Jupyter on your workgroup server; this is described at https://twiki.nevis.columbia.edu/twiki/bin/view/Main/IPython.

\footnotesize

\textsuperscript{60} The way to handle such tasks is with a batch system, which I discuss on the second day of this course.

\textsuperscript{61} I doubt this will be important to your work this summer, but so you can look it up if necessary: In 2020, most Nevis particle-physics systems are running Scientific Linux 6, while the notebook server is running CentOS 7. Sometimes code compiled on SL6 will run on CentOS 7, but more often you'll get crashes with an error message about a missing or incompatible library.

\textsuperscript{62} You can find a list of which files you can change in https://twiki.nevis.columbia.edu/twiki/bin/view/Main/Shell.

A UNIX survival tip: Never let a well-meaning friend start editing your shell initialization scripts for you. I can’t count the number of times I’ve looked at someone’s shell init scripts and saw they were last edited in the 1990s. A user had either forgotten or never knew that their friend had put any such commands there, and so never kept them updated in the years since. These init scripts were copied from user to user for over a decade.

If you edit your scripts yourself, at least you have a chance to maintain them.

\textsuperscript{63} For reference:

If you define a variable in a shell, e.g.,

```
export mywork=~/analysis_work_directory
```

then you can access the variable within your program in ROOT C++:

```cpp
TString my_location = gSystem->Getenv("mywork");
```

In Python:

```
import os
my_location = os.environ["mywork"]
```
Diagonalizing the 2x2 decision matrix

It's probably occurred to you that I've left you with four choices:

<table>
<thead>
<tr>
<th>ROOT C++ on the command line</th>
<th>ROOT C++ in a Jupyter notebook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Python with ROOT on the command line</td>
<td>Python with ROOT in a Jupyter notebook</td>
</tr>
</tbody>
</table>

This tutorial is already 112 pages long, and I've taken longer than I should have to offer you too many options. For simplicity, I've chosen to present ROOT C++ on the command line in Part Three, and Python with ROOT in a Jupyter notebook in Part Four.

If you choose to pursue one of the “off-diagonal” choices, you won’t have much trouble following Parts Three or Four. You were introduced to ROOT C++ in a notebook on page 38. To run Python with ROOT on the command line (including magic commands), the following will set you up on a Nevis particle-physics system:

```bash
module load root
ipython
```

Parts Three and Four of this tutorial present the same commands, exercises, and footnotes. Pick which language you want to learn and go there; Part Three (ROOT C++) starts on the next page and Part Four (Python with ROOT) starts on page 61.

You might even be able to do both Parts Three and Four; once you’ve mastered C++, Python is pretty easy!

![Equation](https://xkcd.com/184/)

Figure 18: [https://xkcd.com/184/](https://xkcd.com/184/) by Randall Munroe

Alt-text: “In fact, draw all your rotational matrices sideways. Your professors will love it!
And then they’ll go home and shrink.”

---

64 The xkcd cartoons in the two parts are different, to give you an incentive to skim both.
Part Three – The C++ Path

Walkthrough: Simple analysis using the Draw command (10 minutes)

It may be that all the analysis tasks that your supervisor will ask you to do can be performed using the tools you learned about in Part One: the Draw command, the TreeViewer, the FitPanel and other simple techniques discussed in the ROOT Users Guide.

However, it's more likely that these simple commands will only be useful when you get started; for example, you can draw a histogram of just one variable to see what the histogram limits might be in C++. Let’s start with the same tasks you just did with TreeViewer.65

If you didn’t copy the example ntuple file, do so now:
   > cp ~seligman/root-class/experiment.root $PWD

If you don’t already have the sample ROOT TTree file open, open it with the following command:
   [ ] TFile myFile("experiment.root")

You can use the Scan command to look at the contents of the Tree, instead of using the TBrowser:
   [ ] tree1->Scan()

If you take a moment to think about it (a habit I strongly encourage), you may ask how ROOT knows that there’s a variable named tree1, when you didn't type a command to create it.

The answer is that when you read a file containing ROOT objects (see “Saving your work, part 2” on page 25) in an interactive ROOT session, ROOT automatically looks at the objects in the file and creates variables with the same name as the objects.

This is not standard behavior in C++; it isn’t even standard behavior when you’re working with ROOT macros. Don't become too used to it!

You can also display the TTree in a different way that doesn't show the data, but displays the names of the variables and the size of the TTree:
   [ ] tree1->Print()

Either way, you can see that the variables stored in the TTree are event, ebeam, px, py, pz, zv, and chi2.

Create a histogram of one of the variables. For example:
   [ ] tree1->Draw("ebeam")

Using the Draw command, make histograms of the other variables.

65 I duplicate some of the descriptive material from the TreeViewer section, in case you decided to skip the quickie tools and get right into the programming.
**Pointers: A too-short explanation (for those who don't know C++ or C)**

(5 minutes)

On the previous page we used the pointer symbol "->" (a dash followed by a greater-than sign) instead of the period "." to issue the commands to the TTree. This is because the variable `tree1` isn't really the TTree itself; it's a 'pointer' to the TTree.

The detailed difference between an object and a pointer in C++ (and ROOT) is beyond the scope of this tutorial. I strongly suggest that you look this up in any introductory text on C++. For now, I hope it's enough to show a couple of examples:

```cpp
[] TH1D hist1("h1","a histogram",100,-3,3)
```

This creates a new histogram in ROOT, and the name of the “histogram object” is `hist1`. I must use a period to issue commands to the histogram:

```cpp
[] hist1.Draw()
```

Here's the same thing, but using a pointer instead:

```cpp
[] TH1D *hist1 = new TH1D("h1","a histogram",100,-3,3)
```

Note the use of the asterisk "*" when I define the variable, and the use of the C++ keyword “new”. In this example, `hist1` is not a 'histogram object,' it’s a ‘pointer’ to the location in computer memory where `hist1` is stored. I must use the pointer syntax to issue commands:

```cpp
[] hist1->Draw()
```

Take another look at the file `c1.C` that you created in a previous example. Note that ROOT uses pointers for almost all the code it creates. As I mentioned above, ROOT automatically creates variables when it opens files in interactive mode; these variables are always pointers.

It’s a little harder to think in terms of pointers than in terms of objects. But you have to use pointers if you want to use the C++ code that ROOT creates for you.

You also have to use pointers to take advantage of object inheritance and polymorphism in C++. ROOT relies heavily on object inheritance (some would say too heavily), and this is often reflected in the code it generates.

---

Figure 19: [http://xkcd.com/138](http://xkcd.com/138) by Randall Munroe

Alt-text: “Every computer, at the unreachable address of 0x-1, stores a secret. I have found it, and it is that all humans are--- SEGMENTATION FAULT”
**Walkthrough: Simple analysis using the Draw command, part 2 (10 minutes)**

Instead of just plotting a single variable, let’s try plotting two variables at once:

```c
[] treel->Draw("ebeam:px")
```

This is a scatterplot, a handy way of observing the correlations between two variables. The `Draw` command interprets the variables as ("y:x") to decide which axes to use.

It’s easy to fall into the trap of thinking that each (x,y) point on a scatterplot represents two values in your ntuple. The scatterplot is a grid; each square in the grid is randomly populated with a density of dots proportional to the number of values in that square.

Try making scatterplots of different pairs of variables. Do you see any correlations?

If you see a shapeless blob on the scatterplot, the variables are likely to be uncorrelated; for example, plot px versus py. If you see a pattern, there may be a correlation; for example, plot pz versus zv. It appears that the higher pz is, the lower zv is, and vice versa. Perhaps the particle loses energy before it is deflected in the target.

Let’s create a “cut” (a limit on the range of a variable):

```c
[] treel->Draw("zv","zv<20")
```

Look at the x-axis of the histogram. Compare this with:

```c
[] treel->Draw("zv")
```

Note that ROOT determines an appropriate range for the x-axis of your histogram (see page 80). Enjoy this while you can; this feature is lost when you start using analysis macros.

A variable in a cut does not have to be one of the variables you're plotting:

```c
[] treel->Draw("ebeam","zv<20")
```

Try this with some of the other variables in the tree.

The symbol for logical AND in C++ is "&&". Try using this in a cut, e.g.:

```c
[] treel->Draw("ebeam","px>10 && zv<20")
```
**Walkthrough: Using C++ to analyze a Tree (10 minutes)**

You can spend a lifetime learning all the in-and-outs of object-oriented programming in C++. Fortunately, you only need a small subset of this to perform analysis tasks with ROOT. The first step is to have ROOT write the skeleton of an analysis class for your ntuple. This is done with the MakeSelector command.

Let's start with a clean slate: quit ROOT if it’s running and start it up again. Open the ROOT tree again:

```cpp
TFile myFile("experiment.root")
```

Now create an analysis macro for `tree1` with MakeSelector. I'm going to use the name “Analyze” for this macro, but you can use any name you want; just remember to use your name instead of “Analyze” in all the examples below.

```cpp
tree1->MakeSelector("Analyze")
```

Switch to the UNIX window and examine the files that were created:

```bash
> less Analyze.h
> less Analyze.C
```

Unless you're familiar with C++, this probably looks like gobbledy-gook to you. (I know C++, and it looked like gobbledy-gook to me... at first.) We can simplify this by understanding the approach of most analysis tasks:

- **Definition** – define the variables we’re going to use.
- **Initialization** - open files, create histograms, etc.
- **Loop** - for each event in the ntuple or Tree, perform some tasks: calculate values, apply cuts, fill histograms, etc.
- **Wrap-up** - display results, save histograms, etc.

You’ve probably already guessed that the lines beginning with // are comments. They describe more than we’re going to use, so I’ll narrow things down on the next page.

---

66 That's four lifetimes, five if you’re studying LaTeX. And you thought you only signed up for a ten-week project! Gosh, I wonder if it takes a lifetime to understand high-energy physics.

67 If you’re bolder or familiar with C++, you don’t have to use MakeSelector to write an analysis class (specifically, a TSelector class) for you; look up TTreereader on the ROOT web site. I use MakeSelector in this tutorial to spare you from having to define a TTreereader for every branch in the TTree. If you're willing to follow the directions for TTreereader, you may get code that will be easier for you to revise in the long run. For an example, see `~seligman/root-class/AnalyzeReader.C`.

68 Many of the comments, as well as the routines SlaveBegin and SlaveTerminate refer to something called PROOF. This is a method of breaking up your ntuple into sections and analyzing each section on a separate CPU core of your computer.

By the way, PROOF has nothing directly to do with batch processing, which I describe on the second day of this course. If you do use PROOF, note that SlaveBegin and SlaveTerminate are where you put your initialization and wrap-up code, respectively, and Begin and Terminate should be “stubs.”

There’s another ROOT class that can speed up ntuple analysis on machines with multiple cores: RDataFrame (see page 86).
**Walkthrough: Using C++ to analyze a Tree (continued)**

Here’s a simplified version of the C++ code from Analyze.C. I’ve removed the automatically generated comments created by ROOT, and minimized the routines SlaveBegin and SlaveTerminate which we won’t use for this tutorial. I also marked the places in the code where you'd place your own commands for Definition, Initialization, Loop, and Wrap-up. Compare the code you see in Analyze.C with what I've put below. If you wish, you can edit the contents of your Analyze.C to match what I’ve done; it will give you practice using **emacs** or whatever text editor you choose.\(^69\)

```c++
#define Analyze_cxx
#include "Analyze.h"
#include <TH2.h>
#include <TStyle.h>

//******** Definition section *********
void Analyze::Begin(TTree * /*tree*/)
{
    TString option = GetOption();

    //******** Initialization section *********
}

void Analyze::SlaveBegin(TTree* tree) {}

Bool_t Analyze::Process(Long64_t entry)
{
    // Don’t delete this line! Without it the program will crash.
    fReader.SetEntry(entry);

    //******** Loop section *********
    // You probably want GetEntry(entry) here.
    return kTRUE;
}

void Analyze::SlaveTerminate() {}

void Analyze::Terminate()
{
    //******** Wrap-up section *********
}
```

Figure 20: Example C++ TSelector macro (Analyze.C). Compare with the code in Python (Figure 27, page 67).

---

\(^{69}\) If you’re feeling lazy, you can copy the “reduced” file from my area:

```
> cp ~seligman/root-class/Analyze.C $PWD
```
Walkthrough: Running the Analyze macro (10 minutes)

As it stands, the Analyze macro does nothing, but let’s learn how to run it anyway. Quit ROOT, start it again, and enter the following lines:

```
[] TFile myFile("experiment.root")
[] treel->Process("Analyze.C")
```

Get used to these commands. You’ll be executing them over and over again for the next several exercises. Remember, the up-arrow and tab keys are your friends!

Let’s examine each of those commands:

- `TFile myFile("experiment.root")` — tells ROOT to load the file experiment.root into memory. This saves you from having to create the TBrowser and double-click the file name every time you start ROOT (and you’ll be restarting it a lot!).

- `treel->Process("Analyze.C")` — load Analyze.C and run its analysis code on the contents of the tree. This means:
  - load your definitions;
  - execute your initializations;
  - execute the loop code for each entry in the tree;
  - execute your wrap-up code.

After the second command, ROOT will pause as it reads through all the events in the Tree. Since we haven’t included any analysis code yet, you won’t see anything happen.

Take another look at Analyze.h, also called a “header file.” (Analyze.C is the “implementation file.”) If you scan through it, you’ll see C++ commands that do something with “branches,” “chains,” and loading the variables from a tree. Fancy stuff, but you don’t have to know about any of the nitty-gritty details. Now go back and look at the top of Analyze.C. You’ll see the line

```
#include "Analyze.h"
```

This means ROOT will include the contents of Analyze.h when it loads Analyze.C. This takes care of defining the C++ variables for the contents of the tree.

---

70 If you’re a real ROOT jockey (and I know you want to be), there’s an even faster way to do this. When I work through the exercises in this course, I start ROOT with this command:

```
> root -l experiment.root
```

This means to run ROOT without displaying the logo, and to open file experiment.root right away. I can omit the TFile command and get to work.
Walkthrough: Making a histogram with Analyze (15 minutes)

Edit the file Analyze.C. In the Definitions section, insert the following code:

```c
TH1* chi2Hist = NULL;
```

This means “define a new histogram pointer and call it chi2Hist.” Why define this as a pointer when plain ol’ variables are easier to use? The short answer is that ROOT uses pointers all the time; for example, if you want to read something from a file, you must always use pointers. The sooner you get used to pointers, the better.\(^{71}\)

Don’t forget the semi-colons “;” at the ends of the lines! You can omit them in interactive commands, but not in macros.

In the Initialization section, insert the following code:

```c
chi2Hist = new TH1D("chi2","Histogram of Chi2",100,0,20);
```

This means “set this pointer to a new histogram object.” We’re doing this here, instead of the Definitions section, because sometimes you want quantities like histogram limits to be variable rather than fixed; e.g., they depend on user input.

In the Loop section, put this in:

```c
GetEntry(entry);
chi2Hist->Fill(*chi2);
```

The first of these two lines means “get an entry from the TTree.”\(^{72}\) Note that the variable entry is an argument to the Process method, so you don’t have to set it. This line will assign values to variables defined in the ntuple: *ebeam, *chi2, and so on.\(^{73}\) In code prepared by MakeSelector, the variables extracted from an ntuple are pointers; they have to be prefixed with “*” to access their values.

The second line means “in the histogram chi2Hist add 1 to a bin that corresponds to the value of *chi2.”

---

\(^{71}\) Why are we defining a pointer then setting it equal to NULL? I’m teaching you to avoid a common problem in programming: uninitialized variables. If we didn’t set chi2Hist to NULL, what would its value be? I don’t know. It would likely be set to zero, which is also the typical value of NULL. But this behavior varies between different C++ compilers. It’s better to be sure.

This is not an issue in the code we’re writing now, but in the future you’ll discover that uninitialized variables cause lots of crashes. Let’s get into good programming habits and avoid them from the start.

\(^{72}\) Actually, in the context of MakeSelector it means “get the data from the TTree pointed to by fReader.SetEntry(entry)”.

\(^{73}\) It’s mildly annoying that whenever you use MakeSelector to create an analysis skeleton, you must remember to put a GetEntry line. Since MakeSelector is doing everything else for us, why can’t it put in that one line too so we don’t have to remember?

The answer is that there’s more that can be done with the TSelector skeleton than we’re doing in this course; do a web search on “TSelector example” for some ideas. Since there are times when a simple line like GetEntry(entry) is not what you want, or you might create an analysis skeleton for one tree and use it on another, MakeSelector makes you put in the GetEntry line manually.
Walkthrough: Making a histogram with Analyze (continued)

This goes in the Wrap-up section:
```cpp
chi2Hist->Draw();
```
You already know what this does; you’ve used it before!

Save the file, quit and restart ROOT, then enter the same commands as before:
```cpp
[] TFile myFile("experiment.root")
[] tree1->Process("Analyze.C")
```
Finally, we’ve made our first histogram with a C++ analysis macro. In the Initialization section, we defined a histogram; in the Loop section, we filled the histogram with values; in the Wrap-up section, we drew the histogram.

“What histogram? I don’t see anything!” Don’t forget: if you have the TBrowser open, you may need to click on the Canvas 1 tab.

How did I know which bin limits to use on chi2Hist? Before I wrote the code, I drew a test histogram with the command:
```cpp
[] tree1->Draw("chi2")
```
Hmm, the histogram’s axes aren’t labeled. How do I put the labels in the macro? Here’s how I figured it out: I labeled the axes on the test histogram by right-clicking on them and selecting SetTitle. I saved the canvas by selecting Save->c1.C from the File menu. I looked at c1.C and saw these commands in the file:
```cpp
chi2->GetXaxis()->SetTitle("chi2");
chi2->GetYaxis()->SetTitle("number of events");
```
I scrolled up and saw that ROOT had used the variable chi2 for the name of the histogram pointer. I copied the lines into Analyze.C, but used the name of my histogram instead:
```cpp
chi2Hist->GetXaxis()->SetTitle("chi2");
chi2Hist->GetYaxis()->SetTitle("number of events");
```
Try this yourself: add the two lines above to the Initialization section, right after the line that defines the histogram. Test the revised Analyze class.
**Exercise 2: Adding error bars to a histogram (5 minutes)**

We're still plotting the chi2 histogram as a solid curve. Most of the time, your supervisor will want to see histograms with errors. Revise the `Analyze::Terminate` method in `Analyze.C` to draw the histograms with error bars.

*Hint:* Look back at “Working with Histograms” on page 17.

*Warning:* The histogram may not be immediately visible, because all the points are squeezed into the left-hand side of the plot. We'll investigate the reason why in a subsequent exercise.

After you make a change to `Analyze.C`, you have to restart ROOT before you run `tree1->Process("Analyze.C")` again. Don’t forget the up-arrow key!

![chi2 histogram](image)

*Figure 21:* What I get when I plot chi2 with the error bars turned on. See Figure 29 on page 70 for how I made this plot.
Exercise 3: Two histograms in the same loop (15 minutes)

Revise Analyze.C to create, fill, and display an additional histogram of the variable ebeam (with error bars and axis labels, of course).

Take care! On page 46 I broke up a typical physics analysis task into pieces: Definition, Initialization, Loop, and Wrap-up; I also marked the locations in the macro where you'd put these steps.

What may not be obvious is that all your commands that relate to definitions must go in the Definitions section, all your commands that are repeated for each event must go in the Loop section, and so on. Don't try to create two histograms by copying the entire program and pasting it more than once; it won't work.

Prediction: You're going to run into trouble when you get to the Wrap-up section and draw the histograms. When you run your code, you'll probably only see one histogram plotted, and it will be the last one you plot.

The problem is that when you issue the Draw command for a histogram, by default it’s drawn on the “current” canvas. If there is no canvas, a default one (our old friend c1) is created. So both histograms are being drawn to the same canvas.

The easiest way to solve this problem is to create a new canvas for each histogram. Look at c1.C to see an example of how a canvas is created. Look up the TCanvas class on the ROOT web site to figure out what the commands do. To figure out how to switch between canvases, look at TCanvas :: cd( ) (that is, the cd( ) method of the TCanvas class).

Is the ebeam histogram empty? Take a look at the lower and upper limit of the x-axis of your histogram. What is the range of ebeam in the ntuple?
Exercise 4: Displaying fit parameters (10 minutes)

Fit the ebeam histogram to a gaussian distribution.

OK, that part was easy. It was particularly easy because the “gaus” function is built into ROOT, so you don’t have to worry about a user-defined function.

Let’s make it a bit harder: the parameters from the fit are displayed in the ROOT text window; your task is to put them on the histogram as well. You want to see the parameter names, the values of the parameters, and the errors on the parameters as part of the plot.

This is trickier, because you have to hunt for the answer on the ROOT web site... and when you see the answer, you may be tempted to change it instead of typing in exactly what's on the web site.

Take a look at the description of the TH1::Draw() method. In that description, it says “See THistPainter::Paint for a description of all the drawing options.” Click on the word THistPainter. There’s lots of interesting stuff here, but for now focus on the section “Fit Statistics.” (This is a repeat of how I found the “surf1” option for Exercise 1 on page 15).

There was another way to figure this out, and maybe you tried it: Draw a histogram, select Options->Fit Parameters, fit a function to the histogram, save it as c1.C, and look at the file. OK, the command is there, mingled with the TPaveStats options... but would you have been able to guess which one it was if you hadn't looked it up on the web site?

Exercise 5: Scatterplot (10 minutes)

Now add another plot: a scatterplot of chi2 versus ebeam. Don’t forget to label the axes!

Hint: Remember back in Exercise 1, I asked you to figure out the name TF2 given that the name of the 1-dimensional function class was TF1? Well, the name of the one-dimensional histogram class is TH1D, so what do you think the name of the two-dimensional histogram class is? Check your guess on the ROOT web site.
Walkthrough: Calculating our own variables (10 minutes)

Let's calculate our own values in an analysis macro, starting with pt from page 29. Let’s begin with a fresh analysis skeleton:

```
[] treel->MakeSelector("AnalyzeVariables")
```

In the Process section, put in the following line (remember: all the ntuple variables are pointers):  

```
Double_t pt = TMath::Sqrt((*px)*(*px) + (*py)*(*py));
```

What does this mean? Whenever you create a new variable in C++, you must say what type of thing it is. We've already done this in statements like

```
TF1 func("user","gaus(0)+gaus(3)")
```

This statement creates a brand-new variable named func, with a type of TF1. In the Process section of AnalyzeVariables, we're creating a new variable named pt, and its type is Double_t.

For the purpose of the analyses that you’re likely to do, there are only a few types of numeric variables that you’ll have to know:

- **Float_t** is used for real numbers.
- **Double_t** is used for double-precision real numbers.
- **Int_t** is used for integers.
- **Bool_t** is for boolean (true/false) values.
- **Long64_t** specifies 64-bit integers, which you probably won't need to use.

Most physicists use double precision for their numeric calculations, just in case.

ROOT comes with a very complete set of math functions. You can browse them all by looking at the TMath class on the ROOT web site, or Chapter 13 in the ROOT User’s Guide. For now, it’s enough to know that TMath::Sqrt() computes the square root of the expression within the parenthesis "()".

Test the macro in AnalyzeVariables to make sure it runs. You won’t see any output, so we’ll fix that in the next exercise.

---

74 You also have to put in that GetEntry line, which I complained about in Footnote 73.

75 If you already know C++: the reason why we don't just use the built-in types float, double, int, and bool is discussed in Chapter 2 of the ROOT Users Guide.

76 To be fair, there are C++ math packages as well. I could have asked you to do something like this:

```c++
#include <cmath>
// ... fetch px and py
pt = std::sqrt((px)*(px) + (py)*(py));
```

The reason why I ask you to use ROOT's math packages is that I want you to get used to looking up and using ROOT’s basic math functions (algebra, trig) in preparation for using its advanced routines (e.g., fourier analysis, finding polynomial roots).
**Exercise 6: Plotting a derived variable (10 minutes)**

Revise AnalyzeVariables.C to make a histogram of the variable $pt$. Don’t forget to label the axes; remember that the momenta are in $GeV$.

If you want to figure out what the bin limits of the histogram should be, I’ll permit you to “cheat” and use the following command interactively:

```cpp
treel->Draw("sqrt(px^2 + py^2)")
```

**Exercise 7: Trig functions (15 minutes)**

Revise AnalyzeVariables.C to include a histogram of $\theta$ (recall page 30).

I’ll make your life a little easier: the math function you want is $TMath::ATan2(y, x)$, which computes the arctangent of $y/x$. It’s better to use this function than $TMath::ATan(y/x)$, because the ATan2 function correctly handles the case when $x=0$.

---

77 If you compare this command with the computation of $pt$ on the previous page, you may be either confused or irritated: When using C++ you have to access the ntuple variables using pointer notation like “(*px)”, while using ROOT directly you can get away with just using the variable names like “px”. This is one of the reasons many folks prefer Python.
Walkthrough: Applying a cut (10 minutes)

The last “trick” you need to learn is how to apply a cut in an analysis macro. Once you've absorbed this, you'll know enough about ROOT to start using it for a real physics analysis.

The simplest way to apply a cut in C++ is to use the if statement. This is described in every introductory C and C++ text, and I won’t go into detail here. Instead I'll provide an example to get you started.

Once again, let's start with a fresh macro:

```cpp
treel->MakeSelector("AnalyzeCuts")
```

Our goal is to count the number of events for which \( p_z \) is less than 145 GeV. Since we're going to count the events, we're going to need a counter. Put the following in the Definition section of AnalyzeCuts.C:

```cpp
Int_t pzCount = 0;
```

Why Int_t and not Long64_t? I find that Int_t is easier to remember. I could even “cheat” and just use int, which will work for this example. You would only have to use the type Long64_t if you were counting more than \( 2^{31} \) entries. I promise you that there aren’t that many entries in this file!

For every event that passes the cut, we want to add one to the count. Put the following in the Process section:

```cpp
if ( (*pz) < 145 )
{
    pzCount = pzCount + 1; // you could use "pzCount++;" instead
}
```

Be careful: it's important that you surround the logical expression \( p_z < 145 \) with parentheses ",\( ()\", but the "if-clause" must use curly brackets ",\( \{\)\".

Now we have to display the value. Again, I'm going to defer a complete description of formatting text output to a C++ textbook, and simply supply the following statement for your Wrap-up section:

```cpp
std::cout << "The number of events with \( p_z < 145 \) is ";
<< pzCount << std::endl;
```

When I run this macro, I get the following output:

```plaintext
The number of events with \( p_z < 145 \) is 14962
```

Hopefully you'll get the same answer.

---

78 Recall that in the lecture I gave at the start of the class, I mentioned that other commonly used data-analysis programs couldn’t handle a large number of events. Can you picture an Excel spreadsheet with more than \( 2^{31} \) rows? ROOT can handle datasets with up to \( 2^{63} \) entries!

Having trouble visualizing powers of 2? Remember that \( 2^{10} \approx 10^3 \), so \( 2^{63} = 2^{6\times (2^{10})} = 2^{6\times (2^{10})^6} \approx 2^{6\times (10^3)^6} = 8 \times 10^{18} \) or about eight quintillion, roughly the number of grains of sand in the world. My claim “ROOT can handle datasets with up to \( 2^{63} \) entries” is theoretical rather than practical.
**Exercise 8: Picking a physics cut (15 minutes)**

Go back and run the macro you created in Exercise 5. If you’ve overwritten it, you can copy my version and copy-n-paste the relevant lines to your code:

```
> cp ~seligman/root-class/AnalyzeExercise5.C $PWD
> cp ~seligman/root-class/AnalyzeExercise5.h $PWD
```

The chi2 distribution and the scatterplot hint that something interesting may be going on. The histogram, whose limits I originally got from the command `tree1->Draw("chi2")`, looks unusual: there’s a peak around 1, but the x-axis extends far beyond that, up to chi2 > 18. Evidently there are some events with a large chi2, but not enough of them to show up on the plot.

On the scatterplot, we can see a dark band that represents the main peak of the chi2 distribution, and a scattering of dots that represents a group of events with anomalously high chi2.

The chi2 represents a confidence level in reconstructing the particle's trajectory. If the chi2 is high, the trajectory reconstruction was poor. It would be acceptable to apply a cut of "chi2 < 1.5", but let's see if we can correlate a large chi2 with anything else.

Write a macro to create a scatterplot of chi2 versus theta. It’s easiest if you just copy the relevant lines from your code in Exercise 7; there are files `AnalyzeExercise7.C` and `.h` in my area if it will help.

Take a careful look at the scatterplot. It looks like all the large-chi2 values are found in the region theta > 0.15 radians. It may be that our trajectory-finding code has a problem with large angles. Let’s put in both a theta cut and a chi2 cut to be certain we’re looking at a sample of events with good reconstructed trajectories.

Use an if statement to only fill your histograms if chi2 < 1.5 and theta < 0.15. Change the bin limits of your histograms to reflect these cuts; for example, there’s no point to putting bins above 1.5 in your chi2 histograms since you know there won’t be any events in those bins after cuts.

It may help to remember that the symbol for logical AND in C++ is `&&`.

A tip for the future: in a real analysis, you'd probably have to make plots of your results both before and after cuts. A physicist usually wants to see the effects of cuts on their data.

I confess: I cheated when I pointed you directly to theta as the cause of the high-chi2 events. I knew this because I wrote the program that created the tree. If you want to look at this program yourself, go to the UNIX window and type:

```
> less ~seligman/root-class/CreateTree.C
```
Exercise 9: A bit more physics (15 minutes)

Assuming a relativistic particle, the measured energy of the particle in our example ntuple is given by

\[ E_{\text{meas}}^2 = p_x^2 + p_y^2 + p_z^2 \]

and the energy lost by the particle is given by

\[ E_{\text{loss}} = E_{\text{beam}} - E_{\text{meas}} \]

Create a new analysis macro (or revise one of the ones you’ve got) to make a scatterplot of \( E_{\text{loss}} \) vs. \( z_v \). Is there a relationship between the \( z \)-distance traveled in the target and the amount of energy lost?

Exercise 10: Writing histograms to a file (10 minutes)

In all the analysis macros we’ve worked with, we’ve drawn any plots in the Terminate method. Pick one of your analysis macros that creates histograms, and revise it so that it does not draw the histograms on the screen, but writes them to a file instead. Make sure that you don't try to write the histograms to “experiment.root”; write them to a different file named “analysis.root”. When you're done, open “analysis.root” in ROOT and check that your plots are what you expect.

In “Saving your work, part 2” on page 25, I described all the commands you're likely to need.

Don't forget to use the ROOT web site as a reference. Here's a question that's also a bit of a hint: What would be the difference between opening your new file with "UPDATE" access, "RECREATE" access, and "NEW" access? Why might it be a bad idea to open a file with "NEW" access? (A hint within a hint: what would happen if you ran your macro twice?)

Figure 23: [https://xkcd.com/1459/](https://xkcd.com/1459/) by Randall Munroe
Exercise 11: Stand-alone program (optional) (60 minutes or more if you don’t know C++)

Why would you want to write a stand-alone program instead of using ROOT interactively? Compiled code executes faster; maybe you’ve already learned about the techniques described in chapter 7 of the ROOT User’s Guide. Stand-alone programs are easier to submit to batch systems that run in the background while you do something else. The full capabilities of C++ are available to you; see footnote 15 on page 6.

I’ll be honest with you: I’m spending all this time to teach you about interactive ROOT, but I never use it. I can develop code faster in a stand-alone program, without restarting ROOT or dealing with a puzzling error message that refers to the wrong line in a macro.

If it’s near the end of the second day, don’t bother to start this exercise. But if you have an hour or more -- well, you’re pretty good. This exercise is a bit of a challenge for you.

So far, you’ve used ROOT interactively to perform the exercises. Your task now is to write a stand-alone program that uses ROOT. Start with the macro you created in Exercise 10: you have a ROOT script (a "C" file) that reads an ntuple, performs a calculation, and writes a plot to a file. Create, compile, and run a C++ program (a "cc" file) that does the same thing.

You can’t just take Analyze.C, copy it to Analyze.cc, and hope it will compile. For one thing, Analyze.C does not have a main routine; you will have to write one. Also, C++ doesn’t know about the ROOT classes; you have to find a way to include the classes in your program.

There are links on this page that may help you:

http://www.nevis.columbia.edu/~seligman/root-class/links.html

(continued on next page)
**Exercise 11: Stand-alone program (continued)**

When you try to compile the program, the following simple attempt won't work:

```bash
> g++ Analyze.cc -o Analyze
```

You will have to add flags to the `g++` command that will refer to the ROOT header files and the ROOT libraries. You can save yourself some time by using the `root-config` command. Take a look at the `man` page for this command:

```bash
> man $ROOTSYS/man/man1/root-config.1
```

Try it:

```bash
> root-config --cflags
> root-config --libs
```

Is there a way of getting all that text into your compilation command without typing it all over again? This is where the UNIX “backtick” comes in handy. Try:

```bash
> g++ Analyze.cc -o Analyze `root-config --cflags`
```

Be careful as you type this; it's not the usual single quote (') but the backtick ('), which is typically located in the upper left-hand corner of a computer keyboard.

Are things still not working? Maybe I want you to think about adding more than one argument to a single command.

That's enough hints.

---

**Figure 25:** [http://xkcd.com/303](http://xkcd.com/303) by Randall Munroe

Alt-text: “Are you stealing those LCDs?” “Yeah, but I’m doing it while my code compiles.”
Part Four – The Python with pyroot Path

If you’re not interested in pyroot or Python, skip or skim this part. Go to page 78.

A brief review (5 minutes)

Skip this page if you’ve gone through the examples in Part Two.

Visit https://notebook.nevis.columbia.edu, type your Nevis account name and password, then select Python 3 from the New pop-up on the upper left. Use File->Rename... to change the name from “Untitled” to anything you want; e.g., “Basic Test”.

What turns Python into pyroot is the inclusion of the ROOT libraries. That’s done with the import command. Cut-and-paste the following into the first, then press SHIFT-ENTER.

```python
from ROOT import TH1D, TCanvas
my_canvas = TCanvas()
example = TH1D("example","example histogram",100,-3,3)
example.FillRandom("gaus",10000)
example.Fit("gaus")
example.Draw()
my_canvas.Draw()
```

Figure 26: http://xkcd.com/353/ by Randall Munroe
**Differences between C++ and Python**

If you already know C++, or you’ve already done Part Three, you should be aware of some differences between using C++ and Python. Pay attention to the prompts; they tell you whether the example is in ROOT/C++ or Python.

- C++ statements end with a semi-colon. Python statements end with a RETURN; no semi-colons.
  ```c++
  myhist.FillRandom("gaus",10000); myhist.Fit("gaus");
  ```
  ```python
  myhist.FillRandom("gaus",10000);
  myhist.Fit("gaus")
  ```

- C++ control structures (e.g., if statements, loops) are indicated by curly braces ({}). Any indentation is for the convenience of humans; the compiler doesn’t need it:
  ```c++
  for (Int_t jentry=0; jentry<nentries; jentry++) {
    Int_t entry = LoadTree(jentry);
    // More stuff
  }
  std::cout << "The loop is over" << std::endl;
  ```
  ```python
  for jentry in xrange( entries ):
    # get the next tree in the chain and verify
    entry = mychain.LoadTree( jentry )
    # More stuff
    print ("The loop is over")
  ```

- C++ uses pointers, and ROOT makes liberal use of them in the code it generates for you (in .C files, etc.). Python does not use pointers, which means you don’t have to remember whether to use "." or "->":
  ```c++
  TH1* hist = new TH1D("example","my second histogram",100,-3,3);
  hist->FillRandom("gaus");
  ```
  ```python
  hist = ROOT.TH1D("example","my second histogram",100,-3,3)
  hist.FillRandom("gaus")
  ```

---

79 I’m simplifying here. All the code in this course you’ve have seen so far use curly braces. I don't want to confuse you any further (except for this footnote).
• You have might picked up on this from the examples above: C++ has strict rules about types, and expects you to specify them when you create a new variable.\(^80\) Python determines types dynamically, and you don't have to specify them:\(^81\)

```
[] Double_t x = 2 * 3;
[] TH1D yae = TH1D("test4","yet another example",200,-100,100);
```

In \[] x = 2*3
In \[] yae = ROOT.TH1D("test4","yet another example",200,-100,100)

• Finally,\(^82\) the ROOT C++ interpreter, cling, knows the names of all the ROOT classes.

```
[] TH1D* example4 = new TH1D("example4","my fourth histogram",100,-3,3);
[] example4.Draw();
```

In Python, you have to explicitly load ROOT, and then indicate that a class is part of ROOT. There are two ways to do this (see [http://wlav.web.cern.ch/wlav/pyroot/using.html](http://wlav.web.cern.ch/wlav/pyroot/using.html)):

Method 1: Import all of ROOT, and indicate which classes are part of ROOT with a prefix:

```
In [] import ROOT
In [] example4 = ROOT.TH1D("example4","my fourth histogram",100,-3,3)
In [] example4.Draw()
```

Method 2: Import the classes you'll need explicitly so you can omit the prefix:

```
In [] from ROOT import TH1D
In [] example4 = TH1D("example4","my fourth histogram",100,-3,3)
In [] example4.Draw()
```

I’m typically going to use the second method in this tutorial, but you can use either one.\(^83\) If you use the second method, be aware that if you add a new ROOT class to your Python script (e.g., TCanvas), you’ll have to add it to your import list:

```
In [] from ROOT import TH1D, TCanvas
```

---

\(^80\) Since I hate to lie to you, I should mention the C++ auto keyword, which lets C++ determine the type for you. Both of the following are correct:

```
TH1D* hist = new TH1D("hist","title",100,-3,3);
auto hist = new TH1D("hist","title",100,-3,3);
```

This can be a great timesaver if a C++ function returns something with a type like `std::vector<std::pair<int,double>>::iterator`. However, you have to be comfortable with C++ before using it, which is why I’m relegating this C++ tip in a footnote in the Python section.

How comfortable with C++ do you have to be before you can use auto? Enough so that you understand why both of the above lines are not the best choice. A better choice would be:

```
auto hist = std::make_unique<TH1D>("hist","title",100,-3,3);
```

Aren’t you glad you’re learning Python?

\(^81\) At least, not for the work you’re likely to be asked to do with pyroot this summer.

\(^82\) … for the purposes of this tutorial. There are many, many more differences between C++ and Python!

\(^83\) If you read up on Python, you’ll discover a third way: `from ROOT import *`

Never do this! It’s an extremely bad programming practice that will lead you into disaster someday. In fact, forget I mentioned it. Take a marker and cross out this footnote.
**Walkthrough: Simple analysis using the Draw command (10 minutes)**

It may be that all the analysis tasks that your supervisor will ask you to do can be performed using the Draw command, the TreeViewer, the FitPanel and other simple techniques discussed in the ROOT Users Guide.

However, it’s more likely that these simple commands will only be useful when you get started; for example, you can draw a histogram of just one variable to see what the histogram limits might be. Let’s start with the same tasks you did with TreeViewer.84, 85

If you didn’t copy the example ntuple file in Part One, do so now:

```
> cp ~seligman/root-class/experiment.root $PWD
```

Open the sample ROOT TTree in the notebook with the following:

```
from ROOT import TFile, gROOT
myFile = TFile("experiment.root")
tree1 = gROOT.FindObject("tree1")
```

The first command imports specific ROOT classes into Python (see the previous page).

That third command means: Look through everything we’ve read in (the “everything” is gROOT) and find the object whose name is "tree1”.

If you’ve done Part Three, note that in Python we have to read in the ntuple explicitly.

In a notebook, you can’t use the Scan method to look at the contents of the Tree (see page 26), but you can display the names of the variables and the size of the TTree:

```
tree1.Print()
```

You can see that the variables stored in the TTree are event, ebeam, px, py, pz, zv, and chi2.

Create a histogram of one of the variables. For example:

```
from ROOT import TCanvas
my_canvas = TCanvas()
tree1.Draw("ebeam")
my_canvas.Draw()
```

While we have to explicitly Draw a canvas, we can re-use a previously-defined canvas (the same way command-line ROOT keeps re-using c1).

Using the Draw commands, make histograms of the other variables.

84 I duplicate some of the descriptions from the TreeViewer discussion, in case you decided to rush into programming and skip the simple tools.

85 If you’re experienced with Python, you may ask why I’m not including NumPy, SciPy, and matplotlib in this tutorial. I want to focus on the ROOT toolkit, even though many tasks (especially in Parts Six and Seven) can be more easily accomplished using those additional packages. I wrestled with this issue for a while, before deciding that there are hundreds of web sites on matplotlib but few sites on ROOT. But I may change my mind next year!
Walkthrough: Simple analysis using the Draw command, part 2 (10 minutes)

Instead of just plotting a single variable, let's try plotting two variables at once:

```cpp
  tree1.Draw("ebeam:px")
  my_canvas.Draw()
```

This is a scatterplot, a handy way of observing the correlations between two variables. The `Draw` command interprets the variables as "(y:x)" to decide which axes to use.

It's easy to fall into the trap of thinking that each (x,y) point on a scatterplot represents two values in your ntuple. The scatterplot is a grid; each square in the grid is randomly populated with a density of dots proportional to the number of values in that square.

Try making scatterplots of different pairs of variables. Do you see any correlations?

If you see a shapeless blob on the scatterplot, the variables are likely to be uncorrelated; for example, plot px versus py. If you see a pattern, there may be a correlation; for example, plot pz versus zv. It appears that the higher pz is, the lower zv is, and vice versa. Perhaps the particle loses energy before it is deflected in the target.

Let's create a “cut” (a limit on the range of a variable):

```cpp
  tree1.Draw("zv","zv<20")
  my_canvas.Draw()
```

Look at the x-axis of the histogram. Compare this with:

```cpp
  tree1.Draw("zv")
  my_canvas.Draw()
```

Note that ROOT determines an appropriate range for the x-axis of your histogram. Enjoy this while you can; this feature is lost when you start using analysis scripts.86

A variable in a cut does not have to be one of the variables you’re plotting:

```cpp
  tree1.Draw("ebeam","zv<20")
```

Try this with some of the other variables in the tree.

ROOT’s symbol for logical AND is `&&`. Try using this in a cut, e.g.:

```cpp
  tree1.Draw("ebeam","px>10 && zv<20")
```

86 After this point, I won’t include the `my_canvas.Draw()` line in future examples, and you’ll have to remember to execute that line. I assume you’ve gotten into the habit of re-using or cut-and-pasting lines between cells.
Walkthrough: Using Python to analyze a Tree (10 minutes)

You can spend a lifetime learning all the in-and-outs of programming in Python. Fortunately, you only need a small subset of this to perform analysis tasks with pyroot.

In ROOT/C++, there’s a method (MakeSelector) that can create a macro for you from a TTree or ntuple. In pyroot there’s no direct equivalent. However, the “analysis skeleton” for an ntuple is much simpler in Python. I’ve got a basic file in my area that you can copy and edit to suit your task.

Copy my example Python script to your directory. Then take a look at it:

```bash
% cp ~seligman/root-class/Analyze.py $PWD
% load Analyze.py
```

The second of the two magic commands will load the contents of Analyze.py into the next notebook cell, all ready for you to play with it.

Most analysis tasks have the following steps:

- **Set-up** - open files, define variables, create histograms, etc.
- **Loop** - for each event in the ntuple or Tree, perform some tasks: calculate values, apply cuts, fill histograms, etc.
- **Wrap-up** - display results, save histograms, etc.

The Python code from Analyze.py is on the next page. I’ve marked the places in the code where you'd place your own commands for Set-up, Loop, and Wrap-up.

You’ve probably already guessed that lines beginning with "#" are comments.

In Python, “flow control” (loops, if statements, etc.) is indicated by indenting statements. In C++, any indentation is optional and is for the convenience of humans. In Python the indentation is mandatory and shows the scope of statements like if and for.

Note that Loop and Wrap-up are distinguished by their indentation. This means that when you type in your own Loop and Wrap-up commands, they must have the same indentation as the comments I put in.

Take a look at the code `mychain.vertex`, which means “get the current value of variable `vertex` from the TTree in mychain.” This is an example; there’s no variable `vertex` in the ntuple in experiment.root. If you want to know what variables are available, typically you’ll have to examine the ntuple/TTree in the TBrowser or display its structure with `Print` as you did on page 64.

---

87 We’re up to at least four lifetimes, five if you completed Part Three, possibly six if you’re learning LaTeX from scratch.
from ROOT import TFile, gDirectory
# You probably also want to import TH1D and TCanvas
# unless you're not drawing any histograms.
from ROOT import TH1D, TCanvas

# Open the file. Note that the name of your file outside this class
# will probably NOT be experiment.root.

myfile = TFile( 'experiment.root' )

# Retrieve the ntuple of interest. In this case, the ntuple's name is
# "treenull. You may have to use the TBrowser to find the name of the
# ntuple in a file that someone gives you.
mychain = gDirectory.Get( 'treenull' )
entries = mychain.GetEntriesFast()

### The Set-up code goes here.
###
for jentry in xrange( entries ):

    # Copy next entry into memory and verify.
    nb = mychain.GetEntry( jentry )
    if nb <= 0:
        continue

    # Use the values directly from the tree. This is an example using a
    # variable "vertex". This variable does not exist in the example
    # ntuple experiment.root, to force you to think about what you're
    # doing.
    myValue = mychain.vertex
    myHist.Fill(myValue)

### The Loop code goes here.
###

### The Wrap-up code goes here
###

Figure 27: Python analysis “skeleton” for a ROOT ntuple.
Compare with the same code in C++ (Figure 20, page 47).
Walkthrough: Using the Analyze script (10 minutes)

As it stands, the Analyze script does nothing, but let’s learn how to run it anyway. Hit SHIFT-ENTER in the cell to run the script.

Python will pause as it reads through all the events in the Tree. Since we haven’t included any analysis code yet, you won’t see anything else happen.

Let’s start making histograms. In the Set-up section, insert the following code:

```python
chi2Hist = TH1D("chi2","Histogram of Chi2",100,0,20)
```

In the Loop section, put this in:

```python
chi2 = mychain.chi2
chi2Hist.Fill(chi2)
```

This goes in the Wrap-up section:

```python
canvas = TCanvas()
chi2Hist.Draw()
canvas.Draw()
```

Don’t forget about the indentation. The lines in the Loop section must be indented to show they’re part of the loop.

Execute your revised script.

Finally, we’ve made our first histogram with a Python script. In the Set-up section, we defined a histogram; in the Loop section, we filled the histogram with values; in the Wrap-up section, we drew the histogram.

How did I know which bin limits to use on chi2Hist? Before I wrote the code, I drew a test histogram:

```python
import ROOT
myFile = ROOT.TFile("experiment.root")
tree1 = ROOT.gROOT.FindObject("tree1")
acanvas = TCanvas()
tree1.Draw("chi2")
acanvas.Draw()
```

(continued on next page)

---

88 You may want to organize your scripts in files outside of notebook cells. This lets you keep track of different versions of your scripts, and allows you to use your favorite text editor. To run an external script from within a notebook cell, use the `%run` magic command; e.g.,

```
%run Analyze.py
```

You can save the contents of notebook cells by putting the `%%writefile` cell magic command at the top of the cell and hitting SHIFT-ENTER; e.g.,

```
%%writefile AnalyzeChi2.py
```
**Walkthrough: Using the Analyze script (continued)**

Hmm, the histogram’s axes aren’t labeled. How do I put the labels in the script? Here’s how I figured it out: I went back to command-line ROOT from Part One and plotted \( \text{chi2} \) with the TreeViewer. I labeled the axes on my test histogram by right-clicking on them and selecting **SetTitle**. I saved the canvas by selecting **Save->c1.C** from the **File** menu. I looked at c1.C and saw these commands in the file:

\[
\begin{align*}
\text{chi2} & \rightarrow \text{GetXaxis()} \rightarrow \text{SetTitle("chi2");} \\
\text{chi2} & \rightarrow \text{GetYaxis()} \rightarrow \text{SetTitle("number of events");}
\end{align*}
\]

I scrolled up and saw that ROOT had used the variable \( \text{chi2} \) for the name of the histogram pointer. I copied the lines into my Python script, but used the name of my histogram instead, and converted the C++ lines into Python. This usually means replacing "\(\rightarrow\)" with ".", and removing the semi-colon from the end:

\[
\begin{align*}
\text{chi2Hist}.\text{GetXaxis()}.\text{SetTitle("chi2")} \\
\text{chi2Hist}.\text{GetYaxis()}.\text{SetTitle("number of events")}
\end{align*}
\]

Try this yourself: add the two lines above to the Set-up section, right after the line that defines the histogram. Test the revised script.\(^{89}\)

---

\(^{89}\) There’s another way to do this in the notebook. Plot the graph with JSROOT:

\[
%\text{jsroot on} \\
\text{acanvas.Draw()}
\]

You can then right-click on the axes, select **Title->SetTitle**, and enter the axis label you want. However, this solution can’t be automated; if you have to generate a hundred histograms each with different axis labels, you’ll want a method you can put into a script.
Exercise 2: Adding error bars to a histogram (5 minutes)

We're still plotting the \( \chi^2 \) histogram as a solid curve. Most of the time, your supervisor will want to see histograms with errors. Revise the script to draw the histograms with error bars.

Hint: Look back at “Working with Histograms” on page 17.

Warning: The histogram may not be immediately visible, because all the points are squeezed into the left-hand side of the plot. We'll investigate the reason why in a subsequent exercise.

![Histogram with error bars](image)

Figure 29: What I get when I plot \( \chi^2 \) with errors bars turned on. In case you're interested, the code below is how I made the above plot. I knew to use gPad to access the temporary histogram from reading the documentation for \( \text{TTree::Draw()} \). I learned about SetTitleOffset by reading the \( \text{TAxis} \) documentation, which led me to the list of TGaxis methods.

```python
from ROOT import TFile, gROOT, TCanvas, gPad
myFile = TFile("experiment.root")
tree1 = gROOT.FindObject("tree1")
my_canvas = TCanvas()
tree1.Draw("chi2","","e")
# Get the temporary histogram used by \text{TTree::Draw()}
htemp = gPad.GetPrimitive("htemp")
htemp.GetXaxis().SetTitle("chi2")
htemp.GetYaxis().SetTitle("number of events")
htemp.GetYaxis().SetTitleOffset(1.5)
my_canvas.Draw()
```

```python
# Get the temporary histogram used by \text{TTree::Draw()}
htemp = gPad.GetPrimitive("htemp")
htemp.GetXaxis().SetTitle("chi2")
htemp.GetYaxis().SetTitle("number of events")
htemp.GetYaxis().SetTitleOffset(1.5)
my_canvas.Draw()
```
Exercise 3: Two histograms in the same loop (15 minutes)

Revise your script to create, fill, and display an additional histogram of the variable ebeam (with error bars and axis labels, of course).

Take care! On page 66 I broke up a typical physics analysis task into three pieces: the Set-up, the Loop, and the Wrap-up; I also marked the locations in the script where you’d put these steps.

What may not be obvious is that all your commands that relate to setting things up must go in the Set-up section, all your commands that are repeated for each event must go in the Loop section, and so on. Don’t try to create two histograms by copying the entire script and pasting it more than once; it may execute, but it will take twice as long (because you’re reading the entire ntuple twice) and you’ll be left with a single histogram at the end.

Prediction: You’re going to run into trouble when you get to the Wrap-up section and draw the histograms. When you run your code, you’ll probably only see one histogram plotted, and it will be the last one you plot.

The problem is that when you issue the Draw command for a histogram, by default it’s drawn on the most recent canvas you created. Both histograms are being drawn to the same canvas.

Some clues to solve this problem: Look at the examples above to see how a canvas is created. Look up the TCanvas class on the ROOT web site to figure out what the commands do. To figure out how to switch between canvases, look at TCanvas::cd() (that is, the cd() method of the TCanvas class). In Python, the namespace delimiter (":" in C++) is a period ("."), so your solution will involve something like c1.cd(). Or you might define a canvas, draw in it, define a new canvas, then draw in the newer one.

Is the ebeam histogram empty? Take at look at the lower and upper limits of your histogram. What is the range of ebeam in the ntuple?

![Figure 30: https://xkcd.com/979/ by Randall Munroe](https://xkcd.com/979/)

NEVER HAVE I FELT SO CLOSE TO ANOTHER SOUL
AND YET SO HELPLESSLY ALONE
AS WHEN I GOOGLE AN ERROR
AND THERE'S ONE RESULT
A THREAD BY SOMEONE WITH THE SAME PROBLEM
AND NO ANSWER
LAST POSTED TO IN 2003

WHO WERE YOU, DENRECORDER??
WHAT DID YOU SEE?!
**Exercise 4: Displaying fit parameters (10 minutes)**

Fit the ebeam histogram to a gaussian distribution.

OK, that part was easy. It was particularly easy because the “gaus” function is built into ROOT, so you don’t have to worry about a user-defined function.

Let's make it a bit harder: the parameters from the fit are displayed in the ROOT text window; your task is to put them on the histogram as well. You want to see the parameter names, the values of the parameters, and the errors on the parameters as part of the plot.

This is trickier, because you have to hunt for the answer on the ROOT web site... and when you see the answer, you may be tempted to change it instead of typing in what’s on the web site (with a prefix of ROOT or including it on the from import line).

Take a look at the description of the TH1::Draw() method. In that description, it says “See THistPainter::Paint for a description of all the drawing options.” Click on the word “THistPainter”. There's lots of interesting stuff here, but for now focus on the section "Fit Statistics." (This is the same procedure for figuring out the “surf1” option for Exercise 1 on page 15).

There was another way to figure this out, and maybe you tried it: Draw a histogram in command-line ROOT, select Options->Fit Parameters, fit a function to the histogram, save it as c1.C, and look at the file. The command is there, but would you have been able guessed how to apply it outside TPaveText if you without the web site?

**Exercise 5: Scatterplot (10 minutes)**

Now add another plot: a scatterplot of chi2 versus ebeam. Don't forget to label the axes!

Hint: Remember back in Exercise 1, I asked you to figure out the name TF2 given that the name of the 1-dimensional function class was TF1? Well, the name of the one-dimensional histogram class is TH1D, so what do you think the name of the two-dimensional histogram class is? Check your guess on the ROOT web site.

![Figure 31](https://xkcd.com/1725/) by Randall Munroe

Alt-text: “The 95% confidence interval suggests Rexthor’s dog could also be a cat, or possibly a teapot.”
Walkthrough: Calculating our own variables (10 minutes)

There are other quantities that we may be interested in apart from the ones already present in the ntuple. One such quantity is $p_T$, which is defined by:

$$p_T = \sqrt{p_x^2 + p_y^2}$$

This is the transverse momentum of the particle, that is, the component of the particle's momentum that's perpendicular to the $z$-axis.

Let's calculate our own values in an analysis macro. Load a fresh copy of that script into your notebook:

```python
%load Analyze.py
```

In the Loop section, put in the following line:

```python
pt = ROOT.TMath.Sqrt(px*px + py*py)
```

Did that not work? To get at the variables `px` and `py`, you have fetch them from the ntuple with something like `mychain.px`. You also have to either have `import ROOT` or `from ROOT import TMath`.

ROOT comes with a very complete set of math functions. You can browse them all by looking at the `TMath` class on the ROOT web site, or Chapter 13 in the ROOT User’s Guide. For now, it's enough to know that `ROOT.TMath.Sqrt()` computes the square root of the expression within the parenthesis "()".

Test the script to make sure it runs. You won't see any output, so we'll fix that in the next exercise.

---

90 To be fair, there are Python math packages as well. I could have asked you to do something like this:

```python
import math
# ... fetch px and py
pt = math.sqrt(px*px + py*py)
```

The reason why I ask you to use ROOT’s math packages is that I want you to get used to looking up and using ROOT’s basic math functions (algebra, trig) in preparation for using its advanced routines (e.g., fourier transforms, multi-variant analysis).
Exercise 6: Plotting a derived variable (10 minutes)

Revise AnalyzeVariables.py to make a histogram of the variable \( p_T \). Don't forget to label the axes; remember that the momenta are in \( \text{GeV} \).

If you want to figure out what the bin limits of the histogram should be, I'll permit you to “cheat” and use the following command interactively:

\[
\text{tree1.Draw("sqrt(px*px + py*py")})
\]

Exercise 7: Trig functions (15 minutes)

The quantity theta, or the angle that the beam makes with the \( z \)-axis, is calculated by:

\[
\theta = \arctan \left( \frac{p_x}{p_z} \right)
\]

The units are radians. Revise your script to include a histogram of theta.

I'll make your life a little easier: the math function you want is \( \text{ROOT.TMath.ATan2} \( y, x \) \), which computes the arctangent of \( y/x \). It's better to use this function than \( \text{ROOT.TMath.ATan} \( y/x \) \), because the ATan2 function correctly handles the case when \( x=0 \).

![Figure 33: http://xkcd.com/447 by Randall Munroe](http://xkcd.com/447)

Alt-text: “They say that if a mathematician doesn’t do their great work by age eleven, they never will.”
Walkthrough: Applying a cut (10 minutes)

The last “trick” you need to learn is how to apply a cut in an analysis macro. Once you’ve absorbed this, you’ll know enough about ROOT to start using it for a real physics analysis.

The simplest way to apply a cut is to use the if statement. This is described in every introductory Python text, and I won’t go into detail here. Instead I’ll provide an example to get you started.

Once again, let's start with a fresh Analyze script:

```
%load Analyze.py
```

Our goal is to count the number of events for which \( p_z \) is less than 145 GeV. Since we're going to count the events, we're going to need a counter. Put the following in the Set-up section:

```
pzCount = 0
```

For every event that passes the cut, we want to add one to the count. Put the following in the Loop section:

```
if ( pz < 145 ):
    pzCount = pzCount + 1
```

Be careful: Remember that indentation is important. The next statement after \( pzCount=pzCount+1 \) must not be indented the same amount, or it will be considered part of the if statement.

Now we have to display the value. Include the following statement in your Wrap-up section:

```
print ("The number of events with \( p_z \) < 145 is", pzCount)
```

When I run this macro, I get the following output:

```
The number of events with \( p_z \) < 145 is 14962
```

Hopefully you'll get the same answer.

---

91 If you’re using Python 2, you may have to omit the parentheses around the arguments of the print statement:

```
print "The number of events with \( p_z \) < 145 is", pzCount
```
**Exercise 8: Picking a physics cut (15 minutes)**

Go back and run the script you created in Exercise 5. If you’ve overwritten it, you can copy my version:

```
% cp ~seligman/root-class/AnalyzeExercise5.py $PWD
% load AnalyzeExercise5.py
```

The chi2 distribution and the scatterplot hint that something interesting may be going on. The histogram, whose limits I originally got from the command `tree1.Draw("chi2")`, looks unusual: there’s a peak around 1, but the x-axis extends far beyond that, up to \( \text{chi2} > 18 \). Evidently there are some events with a large chi2, but not enough of them to show up on the plot.

On the scatterplot, we can see a dark band that represents the main peak of the chi2 distribution, and a scattering of dots that represents a group of events with anomalously high chi2.

The chi2 represents a confidence level in reconstructing the particle’s trajectory. If the chi2 is high, the trajectory reconstruction was poor. It would be acceptable to apply a cut of "\( \text{chi2} < 1.5 \)". but let's see if we can correlate a large chi2 with anything else.

Make a scatterplot of \( \text{chi2} \) versus \( \theta \). It’s easiest if you just copy the relevant lines from your code in Exercise 7; there’s a file AnalyzeExercise7.py in my area if it will help.

Take a careful look at the scatterplot. It looks like all the large-chi2 values are found in the region \( \theta > 0.15 \) radians. It may be that our trajectory-finding code has a problem with large angles. Let’s put in both a \( \theta \) cut and a chi2 cut to be certain we’re looking at a sample of events with good reconstructed trajectories.

Use an if statement to only fill your histograms if \( \text{chi2} < 1.5 \) and \( \theta < 0.15 \). Change the bin limits of your histograms to reflect these cuts; for example, there’s no point to putting bins above 1.5 in your chi2 histograms since you know there won’t be any events in those bins after cuts.

It may help to remember that, in Python, you'll want something like

```
( chi2 < 1.5 and theta < 0.15 )
```

A tip for the future: in a real analysis, you’d probably have to make plots of your results both before and after cuts. A physicist usually wants to see the effects of cuts on their data.

I must confess: I cheated when I pointed you directly to \( \theta \) as the cause of the high-chi2 events. I knew this because I wrote the program that created the tree. If you want to look at this program yourself, go to the UNIX window and type:

```
> less ~/seligman/root-class/CreateTree.C
```
**Exercise 9: A bit more physics (15 minutes)**

Assuming a relativistic particle, the measured energy of the particle in our example ntuple is given by

\[ E_{\text{meas}}^2 = p_x^2 + p_y^2 + p_z^2 \]

and the energy lost by the particle is given by

\[ E_{\text{loss}} = E_{\text{beam}} - E_{\text{meas}} \]

Create a new analysis macro (or revise one of the ones you’ve got) to make a scatterplot of \( E_{\text{loss}} \) vs. \( z \). Is there a relationship between the \( z \)-distance traveled in the target and the amount of energy lost?

---

**Exercise 10: Writing histograms to a file (10 minutes)**

In all the analysis scripts we’ve worked with, we’ve drawn any plots in the Wrap-up section. Pick one of your scripts that creates histograms and revise it so that it does not draw the histograms on the screen but writes them to a file instead. Make sure that you don’t try to write the histograms to “experiment.root”; write them to a different file named “analysis.root”. When you're done, open “analysis.root” with the TBrowser in command-line ROOT and check that your plots are what you expect.

In “Saving your work, part 2” on page 25, I described all the commands you’ll need. Don’t forget to use the ROOT web site as a reference. Here's a question that's also a bit of a hint: What’s the difference between opening your new file with "UPDATE" access, "RECREATE" access, and "NEW" access? Why might it be a bad idea to open a file with "NEW" access? (A hint within a hint: what would happen if you ran your script twice?)
Exercise 11: Stand-alone program (optional) (30 minutes)

Why would you want to write a stand-alone program instead of using ROOT interactively?

- You can’t live in a notebook forever. Typical analysis scripts get so large that you may want to use a regular text editor to work with them, instead of the limited editing available in a notebook cell.
- One method of speeding up a Python program is to use Cython, a Python optimizing compiler: http://cython.org/. You can use Cython within a notebook (see https://twiki.nevis.columbia.edu/twiki/bin/view/Main/IPython), but you’ll get better results if you create a stand-alone program.
- Stand-alone programs are necessary if you want to submit your Python program to a batch system.

So far, you’ve used ROOT interactively to perform the exercises. Your task now is to write a stand-alone program that uses ROOT. Start with the script you created in Exercise 10: you have a notebook cell that reads an ntuple, performs a calculation, and writes a plot to a file. Create a stand-alone program that does the same thing.

If you tried to do the C++ version of this Exercise on page 59, you may have found it difficult. The Python equivalent is much easier. Part of the reason is that all the clues you need are in the condor tutorial I prepared for the second day of the class:

http://www.nevis.columbia.edu/~seligman/root-class/

Look at the instructions for the .py files in that tutorial, then look at the comments in the .py files themselves.

Don’t forget to use module load root if you expect a stand-alone Python program to be able to import the ROOT libraries!

Figure 35: https://xkcd.com/1263/ by Randall Munroe

---

92 Whether this is a programming tip or general life advice I leave up to you.
Part Five – Intermediate topics (for both ROOT/C++ and pyroot)

If you’ve gotten this far in the course, just skim the section titles in this Part. If anything interests you, dive in. Otherwise, use this Part as a reference for the future and move on to the challenges of Part Six.

References

You’ve learned a few techniques to figure out how to do something in ROOT:

- The ROOT web site.
- The ROOT user’s guide.
- The Help menu located in the upper right-hand corner of most command-line ROOT windows.
- Create something “by hand,” save it as a .C file, then examine the file to see how ROOT does it.

There’s one other resource: the example ROOT programs that come with the package. You’ll find them in $ROOTSYS/tutorials. When I ask myself the question “How do I do something complicated in ROOT?” I often find the answer in one of the examples they provide.

I’ve found it handy to make my own copy:

```bash
> cp --arv $ROOTSYS/tutorials $PWD
```

Then I go into the “tutorials” sub-directory, run their examples, and look at their code:

```bash
> cd tutorials
> root -l demos.C
> cd graphics
> root -l first.C
> less first.C
```

You’re going to need these resources as you move into the topics for Parts Six and Seven of the tutorial. I’m going to do less “hand holding” in these notes from now on, because a part of these exercises is to teach you how to use these references.

You can also find the tutorials in this web area, but I find it harder to search for specific examples:


If the distributed nature of the information is annoying to you, welcome to the club! I often have to go hunting to find the answers I want when using ROOT, even after years of working with the package. Occasionally I’ve had no other choice but to examine the C++ source code of the ROOT program itself to find out the answer to a question.

---

93 If the command doesn’t work: Did you remember to type module load root in your UNIX command window? That’s what sets the value of $ROOTSYS.

94 You can still ask me questions during the class; I mean that any remaining written hints in this tutorial will be less detailed or require more thought.
Advanced histogramming notes

The entries in this section were long footnotes in previous edition of this tutorial. I decided to move them into Part Five to make the pages in Parts One, Three, and Four less cluttered.⁹⁵

Alternate gaussian parameterization

In ROOT’s TFormula notation, the “gaus” function is parameterized by "[0]*exp(-(x-[1])^2)/([2]*sqrt(2.*pi))" where "[n]" corresponds to $P_n$. I mention this so that when you become more experienced with defining your own parameterized functions, you can use a different formula:

```
TF1 myGaus("user","[0]*exp(-.5*((x-[1])/[2])^2)/([2]*sqrt(2.*pi))")
```

This may seem cryptic to you now. It’s just a gaussian distribution with a different normalization so that $P_0$ divided by the bin width becomes the number of events in the histogram:

```
myGaus.SetParameters(10.,0.,1.)
hist.Fit("user")
Double_t numberEquivalentEvents = myGaus.GetParameter(0) / hist.GetBinWidth(0)
```

![Figure 36: https://xkcd.com/2118/ by Randall Munroe](https://xkcd.com/2118/)
Alt-text: “It’s the NORMAL distribution, not the TANGENT distribution.”

Automatic histogram binning

As you’ve noticed when working with a command like `tree1->Draw("zv")`. ROOT can automatically determine the appropriate axis range of a plot for you. You can use the same trick; it is:

```
TH1* hist = new TH1D(...);  // define your histogram
hist->SetCanExtend(TH1::kXaxis);  // allow the histogram to re-bin itself
hist->Sumw2();  // so the error bars are correct after re-binning
```

“Re-binning” means that if a value is supplied to the histogram that's outside its limits, it will adjust those limits automatically. It does this by summing existing bins then doubling the bin width; the bin limits change, while the number of histogram bins remains constant.

---

⁹⁵ “What? There was a version of this tutorial that was more cluttered?” Just for that, you get to work through all the exercises in Parts Six and Seven.
Histogram arithmetic

Suppose you're told to fill two histograms, then perform arithmetic on them; most often this will be adding histograms, but you can also subtract, multiply, and divide histogram contents. If you do this, call the "Sumw2" method of both histograms before you fill them; e.g.,

```cpp
TH1* hist1 = new TH1D(...);
TH1* hist2 = new TH1D(...);
hist1->Sumw2();
hist2->Sumw2();

// Fill your histograms
hist1->Fill(...);
Hist2->Fill(...);

// Add hist2 to the contents of hist1:
hist1->Add(hist2);
```

If you forget `Sumw2`, then your error bars after the math operation won't be correct. General rule: If you're going to perform histogram arithmetic, use `Sumw2` (which means "sum the squares of the weights"). Some physicists use `Sumw2` all the time, just in case.

---

![Image](https://xkcd.com/759/)

Alt-text: "Handy exam trick: When you know the correct answer but not the correct derivation, derive blindly forward from the givens and backward from the answer, and join the chains once the equations start looking similar. Sometimes the graders don’t notice the seam."
**Directories**

A question for you: What will happen if you execute the following code in C++?

```cpp
TFile* file = new TFile("experiment.root");
TH1D* hist = new TH1D("example","example",100,-3,3);
hist->FillRandom("gaus",10000);
file->Close();
hist->Draw();
c1->Draw();
```

If you’re more accustomed to Python:

```python
import ROOT
file = ROOT.TFile("experiment.root")
hist = ROOT.TH1D("example","example",100,-3,3)
hist.FillRandom("gaus",10000)
file.Close()
hist.Draw()
```

Did you guess that the code will crash? The C++ version will give a segmentation fault; the Python version will complain that `hist` is now an object of `PyROOT_NoneType`. You may have even seen a crash like this before when working on Exercise 10. You’ve probably already guessed that the cause of the problem are “directories” (since that’s the title of this section), but how?

A directory in ROOT (the TDirectory class) is a way of organizing ROOT’s objects. It’s like a directory or folder on disk, only ROOT’s directories typically hold only ROOT classes: TTrees, histograms, etc. They’re used mostly to organize the contents of ROOT disk files (see Exercise 12 on page 98 for more) but you can define a directory in ROOT’s memory without writing it to disk, the same way you can have a histogram in ROOT’s memory without it being written to a file.

For the most part, you don’t have to think about directories during an active ROOT session, but the example code above illustrates an unusual case. Let’s see why it fails. To see the name of the directory you’re using in ROOT, execute the following in C++:

```cpp
TDirectory::CurrentDirectory()->GetName()
```

In Python:

```python
ROOT.TDirectory.CurrentDirectory().GetName()
```

Give it a try.²⁶ Start an interactive ROOT session and copy-and-paste the above command to see the name of the current directory (it will probably be “RInt” or “PyROOT”). Then copy-and-paste the TFile command in the example code above, then look at the directory name again.

It looks like when you open a file, ROOT automatically creates a TDirectory with that file’s name and makes that your default directory. This may remind you a bit of Exercise 3. There you had to be careful about which TCanvas you wrote to. Here it’s important to understand in which TDirectory you’re creating objects.

Look at the line in the example code that defines a new histogram. In which TDirectory will the histogram be created? I’m sure you got the correct answer: “experiment.root”.

Now execute the example code up to and including the line where we close the file. Once again, look

²⁶ If you’d like a visual guide, you may want to start the TBrowser first so you can see the directory and histogram appear and disappear as you paste the commands.
at the directory name. We’re not in “experiment.root” anymore.

What happens if we try to draw hist now? We’ll get an error. The reason why is that when we closed the file, ROOT also removed its associated directory. When the TDirectory “experiment.root” was removed, everything in it was removed as well, including hist. The reason for the error when we try to draw the histogram is that hist refers to a region of memory that doesn’t exist anymore.

The fix for the above example code is simple: swap the TFile and TH1D lines. Then hist is defined in a TDirectory that isn’t going away.

Again, for the most part you don’t have be concerned with the TDirectory class. However, it’s a good idea to keep to the practice: Don’t create objects when you have an open file, unless you’re going to write that object to that file.

Perhaps you’re asking yourself: hist was created while experiment.root was open. Does this mean the histogram was added to the disk file? No, for two reasons: we didn’t use a Write() method on anything, and the file was opened read-only (see Exercise 10).

Figure 38: https://xkcd.com/981/ by Randall Munroe
Moral: Be careful how you organize your directories!
JupyterLab

You learned about Jupyter in Part Two. JupyterLab is the next phase of the Jupyter project. Eventually it will become the standard Jupyter interface. If you wish, you can experience the future today.

JupyterLab is another step along the road to making Jupyter a full-fledged IDE (integrated development environment). Here’s an example: When I use Jupyter, typically I see something like this:

![JupyterLab interface](image)

Figure 39: A typical Jupyter view.

I prefer to use tabs instead of separate browser windows, but otherwise your experience with Jupyter is probably the same: the main Jupyter file browser is in one window, while the Jupyter notebooks are each in separate windows of their own.

This is what I see when I set up the same tasks in JupyterLab:
Figure 40: A typical JupyterLab view.

The entire notebook interface is contained in a single browser window. JupyterLab offers more, such as a text editor with syntax highlighting and the ability to execute code within Markdown documents. For more information, see the user’s guide at


If you want to try JupyterLab, the simplest way to switch is to edit the URL of your main Jupyter page. For example, when I use Jupyter, I see the following URL:

https://seligman.notebook.nevis.columbia.edu/user/seligman/tree

To switch to JupyterLab, change the characters `tree` to `lab`. For example, what I would use is:

https://seligman.notebook.nevis.columbia.edu/user/seligman/lab

To switch back to Jupyter, select Launch Classic Notebook from JupyterLab’s Help menu.

If you want to always use JupyterLab instead of Jupyter, create or edit the file `~/.jupyter/jupyter_notebook_config.py` and include the following line:

```python
c.NotebookApp.default_url = '/lab'
```
Dataframes

Using dataframes, each of the exercises 2 through 9 above can be written in 3 lines of code. You don’t need to create event loops with macros or analysis skeletons; the RDataFrame class and its associated methods handle all of that for you.97, 98

The simplest way to view RDataframe is as a way to treat an ntuple like a spreadsheet. You can derive new columns, and perform operations on a column like counting entries, summing the values, or finding the maximum/minimum value. You can also perform row-wise operations such as applying a cut (a “filter” in RDataFrame).

Here’s a simple example in Python:

```python
import ROOT
dataframe = ROOT.RDataFrame("tree1","experiment.root")
example = dataframe.Rotate("pt","sqrt(px*px + py*py)") \ .Filter("pz < 145").Count().Hist1D("pt")
```

This defines a dataframe that contains our standard example ntuple tree1 from experiment.root. It then applies the following operations to the ntuple:

- defines a new column, pt, from a formula;
- applies a cut of pz < 145 to all the rows;
- counts the number of rows that pass the cut;
- makes a histogram of pt for all the rows that pass the cut.

To access the value of the number of rows that pass the cut:

```python
print("The number of events with pz < 145 is",example.GetValue())
```

To draw the histogram, assuming you’ve defined a suitable canvas:

```python
example.Draw()
```

For a more complete example, including the equivalent code in C++, copy the Python notebook RDataFrameExercises.ipynb from ~seligman/root-class and open it via Jupyter.

You can also see other examples in these two equivalent areas (see page 79):

- The tutorials area $ROOTSYS/tutorials/dataframe;

(continued on next page)

---

97 The term “dataframe” is also an important component of the Python data analysis package pandas (https://pandas.pydata.org/pandas-docs/stable/getting_started/overview.html) and the R programming language (https://www.tutorialspoint.com/r/r_data_frames.htm). Don’t confuse ROOT’s dataframes with pandas’ or R’s. There is some overlap of concepts, but they’re different things with the same name.

98 The current RDataFrame class was introduced in ROOT 6.14. From ROOT 6.10 to 6.12, the class was called ROOT::Experimental::TDataFrame. Prior to 6.10, you won’t find dataframes in ROOT at all. Since this is an actively evolving feature of ROOT, you’ll want to check which version of ROOT your collaboration uses. The notebook server uses the latest stable version of ROOT but collaborations often stick with a particular older ROOT version.
Here are other advantages of RDataFrame:

- It's easy to set up RDataFrame to use multiple threads, which greatly speeds up execution. Generally, you can do this in Python by just adding the line:
  
  ```python
  ROOT.ROOT.EnableImplicitMT
  ```

In C++:

  ```c++
  ROOT::EnableImplicitMT();
  ```

- Although I only show examples using the ntuple tree1, you can also use other file formats as input to dataframes; e.g., TTrees and CSV files.

- As noted above, you don’t have to worry about event loops.

- You can easily save modified dataframes (via the Snapshot method) to preserve the work you’ve done.

With all these benefits, why didn’t I just use RDataFrame in Parts Three and Four and save you some of the hassle?

- A teaching reason: To be able to work with dataframes, you need to have some formal understanding of reading rows via an event loop. It’s hard to do that without seeing loop code at least once.

- Another teaching reason: You need to know how to code loops (and other control structures) in both Python and C++ if you’re to work with those languages for anything other than ROOT.

- RDataFrame “stages” its tasks using a technique called “lazy evaluation.” This means RDataFrame won’t read the dataframe from disk until the first actual call that requires using the data to compute a value.

Consider:

  ```python
  countPz = dataframe.Filter("pz < 145").Count()
  hist = dataframe.Define("pt","sqrt(px*px + py*py)"") \ 
  .Define("theta","atan2(pt,pz)").Histo1D("pt")
  print ("The number of events with pz < 145 is",countPz.GetValue())
  hist.Draw()
  ```

When you execute the above code, RDataFrame will “stack” the Filter, Define, and Histo1D actions. It will only read the ntuple when it executes countPz.GetValue, which requires a concrete numeric value. As it reads the ntuple it will perform all the stacked actions.

This means you want to have a strong sense of what RDataFrame actions are staged and which retrieve values. Consider the following code, which just moves a single line compared to the above code:

  ```python
  countPz = dataframe.Filter("pz < 145").Count()
  print ("The number of events with pz < 145 is",countPz.GetValue())
  hist = dataframe.Define("pt","sqrt(px*px + py*py)"") \ 
  .Define("theta","atan2(pt,pz)").Histo1D("pt")
  hist.Draw()
  ```

If you execute this code, RDataFrame will read the ntuple to get the value of countPz. It will then stage two more Define actions and the Histo1D action, and the read the ntuple again to be able to draw the histogram.
Do things right, and you’ll only read an ntuple from disk once. Do things wrong, and you could get a slow program that reads an ntuple from disk over and over again.

- RDataFrame allows you to write your own functions that manipulate each row in a dataframe. That sounds great, but if you’re going to turn multi-threading on, you have to understand how to write multi-threaded code. There are some notes in the tutorials and the RDataFrame ROOT documentation to help with this.

- To can write your own code for RDataFrame to execute in Python up to a point, but there’s no equivalent to functors and lambdas in Python; at least, not in a form that can be passed via Python-to-C++ conversion facilities available in ROOT. You can get some idea of the limits by looking at the tutorials I reference above; if you see a .C file without a corresponding .py, it means not even the ROOT experts could figure out how to implement the C++ function in Python.

With all that said, I’m in favor of using dataframes and plan to use RDataFrame in my projects in the future. But this is definitely a subject in which you can become an expert faster than I can!

**uproot**

From RDataFrame, let’s go to the other end of the spectrum: ROOT I/O without using ROOT. The Python uproot package reads ROOT files using only Python and numpy. It’s particularly handy if you were already a Python expert before taking the ROOT class, and would rather not have to touch ROOT again if you can help it.

I’ve installed uproot on the Python 3 installations available at Nevis. For documentation, see [https://github.com/scikit-hep/uproot](https://github.com/scikit-hep/uproot)

![Figure 41](https://xkcd.com/2054/) by Randall Munroe

Hopefully your use of ROOT data will be more rational.
Installing ROOT on your own computer

Either you have no choice, or you’ve decided to ignore my warning on page 6. Here are various methods to install ROOT on your own computer. They are listed in ascending order of how complex the various methods are.

Docker

Docker (https://www.docker.com) is probably the best method of running Jupyter+pyroot with a minimum of fuss. Its disadvantage is that it requires administrative access to the host computer system (e.g., your laptop), both to install Docker and to run the Docker container.

The first step is to install Docker. For Mac and Windows systems, use Docker Desktop (https://hub.docker.com/?overlay=onboarding); there's a different procedure needed for Linux systems (https://runnable.com/docker/install-docker-on-linux).

Once Docker is installed and running, you'll be able to download and run a Docker container:

```
sudo docker run -p 8080:8080 -v $PWD:/work wgs eligman/jupyter-pyroot
```

(Windows users will probably need to use `%CD%` instead of `$PWD`.)

The first time you run this command, it will download a ~2.5GB container. Give it time.

Finally, you'll see some output. Look at that output carefully, as it will tell you how to access Jupyter via a web browser. For example, assume the output contains something like this:

```
To access the notebook, open this file in a browser:
file:///root/.local/share/jupyter/runtime/nbserver-1-open.html
```

Or copy and paste one of these URLs:

```
http://649d0c4b4dc1:8080/?token=97d7242fc79734f1429bc425c627ccc4f586675c01ecdd9c
```

```
http://127.0.0.1:8080/?token=97d7242fc79734f1429bc425c627ccc4f586675c01ecdd9c
```

Then start up a web browser and visit

```
http://127.0.0.1:8080/?token=97d7242fc79734f1429bc425c627ccc4f586675c01ecdd9c.
```

You'll see the standard Jupyter home page.

That will get you started. The next few sub-sections are for refining your use of Docker.
Changing the port

Consider the command:
```
sudo docker run -p 8080:8080 -v $PWD:/work wgseligman/jupyter-pyroot
```
That first 8080 is the port to use on your local computer. If you want to use a different port on your
computer (for example, you're already using port 8080 for something else), change that first 8080 to
a different port. Note that if you change the port, you'll also have to change the port in the URL in
the output; e.g.,
```
sudo docker run -p 7000:8080 -v $PWD:/work wgseligman/jupyter-pyroot
```
means you'll have to change:
```
http://127.0.0.1:8080/?token=97d7242fc79734f1429bc425c627ccc4f586675c01ecdd9c
```
to:
```
http://127.0.0.1:7000/?token=97d7242fc79734f1429bc425c627ccc4f586675c01ecdd9c
```

Changing the directory

Again, consider:
```
sudo docker run -p 8080:8080 -v $PWD:/work wgseligman/jupyter-pyroot
```
That $PWD (%CD% in Windows) just means “the current directory.” The execution environment
within the container uses /work for its files; the -v option in the command means "map /work to
the current directory in the terminal." If you'd like to use a different directory on your computer as
the work directory for the Docker container, just substitute that directory for $PWD. For example:
```
sudo docker run -p 8080:8080 -v ~jsmith/root-class:/work wgseligman/jupyter-pyroot
```

Changing the container

You can use New -> Terminal within Jupyter to get a shell. Within that shell, you can modify
anything within the container you want; for example, you can use pip3
(https://pip.pypa.io/en/stable/user_guide/) to install new Python packages or yum
(http://yum.baseurl.org/wiki/YumCommands.html) to install new Linux packages.99

However, any changes you make to the Docker container won't be automatically saved when you
quit the container. When you next start the container, it will start “fresh.” If you want to save your
changes, you'll have to commit them
(https://docs.docker.com/engine/reference/commandline/commit/).

For example, assume that you've made some changes to your copy of the jupyter-pyroot container.
Look up the ID of the container as assigned by your local docker process:
```
sudo docker container ls
```
```
CONTAINER ID        IMAGE                  COMMAND                  CREATED              STATUS            PORTS                  NAMES
1105371318e8        wgseligman/jupyter-pyroot   "jupyter notebook ..."   [2 days ago]          Up 2 days (0:03)   0.0.0.0:8080->8080/tcp   jupyter-pyroot
```
Your output will be different; I’ve omitted most of the columns, and you'll have a different
CONTAINER ID. Commit a revised container using your own image name:
```
sudo docker commit 1105371318e8 $USER/jupyter-pyroot
```

99 If you install something of general interest, let me know. I may add it to the main jupyter-pyroot container.
You'll can see your new image with the `docker images` command (https://docs.docker.com/engine/reference/commandline/images/). For example, if `$USER` is "jsmith":

code sample

```
sudo docker images
```

<table>
<thead>
<tr>
<th>REPOSITORY</th>
<th>TAG</th>
<th>IMAGE ID</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>jsmith/jupyter-pyroot</td>
<td>latest</td>
<td>97ca601cbf9c</td>
<td>[...]</td>
</tr>
<tr>
<td>docker.io/wgseligman/jupyter-pyroot</td>
<td>latest</td>
<td>16c3bbdc8144</td>
<td>[...]</td>
</tr>
</tbody>
</table>

From that point forward, you'll probably want to run your new container with your changes:

code sample

```
sudo docker run -p 8080:8080 -v $PWD:/work jsmith/jupyter-pyroot
```

### Docker container notes

I prepared the container `wgseligman/jupyter-pyroot` to be similar to the environment of the notebook server; for example, it runs the same version of the OS and of ROOT (as of Aug-2020, that's CentOS 7 and ROOT 6.22.00).

A little bit web searching will show there are other ROOT containers available. For example:

code sample

```
sudo docker run -p 3000:8080 pedwink/pyroot-notebook
```

That particular container uses Fedora 28 and ROOT 6.14, and it also offers Python 2 versions of its notebook kernels (`wgseligman/jupyter-pyroot` only offers Python 3).

So if you can't find the feature you want in `wgseligman/jupyter-pyroot`, hunt around a bit. It's probably out there.

### Singularity

If you don't have admin access to your local computer, or you simply prefer it, you can use Singularity instead (https://sylabs.io/guides/3.5/user-guide/). You still need admin access to install Singularity, or a willing sysadmin to do it for you. (Singularity is installed on all the systems in the Nevis particle-physics Linux cluster.)

To download the container and convert it to Singularity's `.sif` format:

code sample

```
singularity pull docker://wgseligman/jupyter-pyroot
```

After some processing, you'll have the image file `jupyter-pyroot_latest.sif`. Then you can run Singularity on that container:

code sample

```
singularity run --bind=$PWD:/work jupyter-pyroot_latest.sif
```

Note that while you can change the mapping of the `/work` directory within the container (see the Docker instructions above), you can't change Jupyter's binding to port 8080. This might be a problem if you're running on a shared computer system and more than one user wants to run this container at the same time.

### Anaconda

Docker and Singularity are OS-level containers. Anaconda is an environment-level container; it doesn't change the operating system, but it allows you download and execute packages in your home directory.

If you use the Nevis Linux cluster, then you should consider using environment modules (see 100).

---

100 In contrast to emulators like VMware, which are machine-level containers.
page 10) over Anaconda. But if you're on a different system, or the Nevis environment modules don't offer the package or version you're looking for, Anaconda is a better choice. You can install Anaconda in your home directory (https://docs.anaconda.com/anaconda/install/) so admin access is not necessary.

Once you've installed Anaconda, you’ll probably have to include conda-forge:
https://conda-forge.org/.

To install Jupyter/ROOT, this command is supposed to work:
conda create --name jupyter-pyroot jupyter python root

However, I've found this method to be unreliable. Typically there's no problem with jupyter or python, but installing ROOT via Anaconda is hit-or-miss.

Assuming you succeed, you can run the jupyter command:

jupyter notebook

or if you want control of the port:

jupyter notebook --no-browser --port=XXXX

Note that because Anaconda changes your execution environment, it may be incompatible with other environment setups (such as MicroBooNE’s LArSoft, ATLAS’ Athena, or Nevis’ module load command).

**Other packaged distributions**

There are other packaging systems than Anaconda; I only emphasized that one because it’s available on Mac OS X, Windows, and Linux. But if you’re already using a package system, ROOT may already be a part of it.

For example, MacPorts has both ROOT and Jupyter. In RHEL-derived Linux systems, the EPEL repository has also has both ROOT and Jupyter.

The difficulty with some of these packaged distributions is that the ROOT+Jupyter integration might need some work on your part.

---

Figure 42: [https://xkcd.com/1349/](https://xkcd.com/1349/) by Randall Munroe
The hard way: compiling ROOT and Jupyter from scratch

I repeat my advice from page 6: Don’t.

Obviously, it’s possible to install these packages from scratch; I do it all the time. But it can take a while to learn how to do it. You’d learn a lot about UNIX, but you’ll be learning neither ROOT nor physics. Don’t expect me to break from teaching other students about ROOT to teach you about your C++ compiler and the location of your Python distribution in your directory hierarchy.

Now that you have been warned, here are the places to start:

- Python (if it’s not already installed on your system): https://wiki.python.org/moin/BeginnersGuide/Download
- ROOT: https://root.cern.ch/downloading-root

Please keep the following in mind:

- These are not applications that you can double-click to automatically install. The process requires some knowledge of the command shell.
- Read the installation documentation for each package. Use some thought and initiative. If you aren’t familiar with UNIX shells before you started this process, you will be once you finish!
- The dockerfile I used to create the wgseligman/jupyter-pyroot container may provide a clue for how to create your own installation. It’s at https://github.com/wgseligman/docker-jupyter-pyroot/blob/master/Dockerfile.

Figure 43: https://xkcd.com/1739/ by Randall Munroe
Alt-text: “What was the original problem you were trying to fix?”
“Well, I noticed that one of the tools I was using had an inefficiency that was wasting my time.”
Part Six – Advanced Exercises

If you still haven’t finished the exercises for Parts One, Three, or Four, then keep working on them. The following exercises are relevant to larger-scale analyses but may not be relevant to the work that you’ll be asked to do this summer.

If this class is your first exposure to programming, then these exercises are hard. The smart-aleck footnotes and xkcd cartoons aren’t going to change that. Don’t feel bound by the suggested times. Use the references to learn enough about programming to try to get the next exercise done by the end of the workshop.

It’s your choice whether to do the exercises in C++ or Python. I’m going to discuss them in C++ terms, mainly because that’s my preferred programming language. Working in pyroot will pose its own set of challenges. You’ll learn something either way!

Before we get to those exercises, let’s consider some more advanced topics in ROOT.

Working with folders inside ROOT files

As you worked with the TBrowser, you may have realized that ROOT organizes its internal resources in the form of “folders,” which are conceptually similar to the hierarchy of directories on a disk. You can also have folders within a single ROOT file.

Folders are discussed in Chapter 10 in the ROOT Users Guide, but I have not seen the approach they describe (the TTask class) used in any experiment on which I’ve worked. Instead I’ll focus on ROOT folders in the way they’re more often used (if they’re used at all): to organize objects within a file.

Copy the file folders.root from my root-class directory into your own, and use the ROOT TBrowser to examine its contents.

You’ll see three folders within the file: example1, example2, and example3. Each of these folders will be the basis of the next three exercises.

All three exercises will require you to make a plot of data points with error bars. You’ll want to use the TGraphErrors class for this.\footnote{For Python programmers: Because I have a generous soul, I’ll permit you to use matplotlib instead of TGraphErrors for your x-y plots. The fact that I have no way to stop you has nothing to do with it.}

Figure 44: \url{http://xkcd.com/688} by Randall Munroe
**C++ Container classes**

Go back to the description of the TGraphErrors class. To create a TGraphErrors object, you need to supply some arguments.

These are all different ways to construct a plot with error bars:

- **TGraphErrors()** – This is used internally by ROOT when reading a TGraphErrors object from a file. You won’t use this method directly.
- **TGraphErrors(Int_t n)** – You use this when you just want to supply TGraphErrors with the number of points that will be in the graph, then use the SetPoint() and SetPointError() methods to assign values and errors to the points.
- **TGraphErrors(const TGraphErrors& gr)** – This is called a “copy constructor” in C++, and is used when you copy a TGraphErrors object. You can ignore this.
- **TGraphErrors(const TH1* h)** – You use this to create a TGraphErrors plot based on values in a histogram.

Now that I’ve given you a guide to four ways to construct a TGraphErrors object, you can probably figure out what the others are: to create one from the contents of a file, and to create plots from either float or double-precision… somethings.

Those somethings are containers. In ROOT and C++, there are three general categories of containers you have to know about.

**Arrays**

Do a web search on “C++ arrays” to learn about these containers. Briefly, to create a double-precision array of eight elements, you could say:

```cpp
Double_t myArray[8];
```

To refer to the 3rd element in the array, you might use (remember, in C++ the first element has an index of 0):

```cpp
Int_t i = 2;
myArray[i] = 0.05;
```

If you’re new to C++, it won’t be obvious that while myArray[2] is a Double_t object, the type of the name myArray (without any index) is Double_t*, or a pointer to a Double_t (see page 44).

Getting confused? Let’s keep it simple. If you’ve created arrays with values and errors…

```cpp
Double_t xValue[22];
Double_t xError[22];
Double_t yValue[22];
Double_t yError[22];
```

…and you’ve put numbers into those arrays, then you can create a TGraphErrors with:

```cpp
TGraphErrors* myPlot = new TGraphErrors(22,xValue,yValue,xError,yError);
```

Did you notice a problem with that example? I had to supply a fixed value for the number of points in each array to make the plot. In general, you won’t be able to do that; in fact, in

---

102 If you’re doing these exercises in Python: You’ll want to read up on numpy arrays instead. Fortunately, numpy arrays will automatically be converted to C++ arrays when they’re passed as arguments to ROOT methods.
exercises 15 and 16 below you can’t do that.

In C++, one way to get around this problem is to use “dynamic arrays.” I’ll let you read about those on the web (search on “C++ dynamic arrays”), but I’m not going to say more about them, because I rarely use them.

**ROOT’s containers**

ROOT’s container classes are described in chapter 16 of the ROOT Users Guide.

In the TGraphErrors constructors, the TVectorF and TVectorD classes are containers for single- and double-precision real numbers respectively. Click on the class names in the ROOT web site to see the clear and detailed explanation of how to use them.\(^{103}\)

I’ll be blunt here, and perhaps editorialize too much: I don’t like ROOT’s collection classes. The main reason is that most of them can only hold pointers to classes that inherit from TObject. For example, if you wanted to create a TList that held strings or double-precision numbers (TString and Double_t in ROOT), you can’t do it.\(^{104}\)

You need to know a little about ROOT’s collection classes to be able to understand how ROOT works with collections of objects; exercise 16 below is an example of this. For any other work, I’m going to suggest something else:

**C++ Standard Template Library (STL)**

Do a web search on “standard template library”. This will probably take you to SGI’s web site at first. Skim a few sites, especially those that contain the words “introduction” or “tutorial”. You don’t have to get too in-depth; for example, you probably don’t have enough time today to fully understand the concept of iterators.

Did you guess that STL is my preferred method of using containers in C++?

The Standard Template Library is an important development in the C++ programming language. It ties into the concepts of design patterns and generic programming, and you can spend a lifetime learning them.\(^{105}\)

---

\(^{103}\) If you did this and are puzzled by my description, search the web for the definition of “sarcasm.”

\(^{104}\) In previous versions of this tutorial, I spent a couple of pages discussing object inheritance, and what it means to, e.g., “inherit from TObject.” The new ROOT web documentation makes it harder to determine object inheritance; you have to actually look at ROOT’s C++ source code. I decided to spare you that as much as possible.

\(^{105}\) I’ve lost track of the number of your lifetimes I’ve spent. You’re probably tired of the joke anyway.
Vectors

For the work that you’ll be asked to do in Parts Six and Seven, and probably for the rest of this summer, there’s only one STL class you’ll have to understand: vectors. Here are the basics:

If you want to use vectors in a program, or even a ROOT macro, you have to put the following near the top of your C++ code:

```cpp
#include <vector>
```

To create a vector that will contain a certain type, e.g., double-precision values:

```cpp
std::vector<Double_t> myVector;
```

If you want to create a vector with a fixed number of elements, e.g., 8:

```cpp
std::vector<Double_t> myOtherVector(8);
```

To refer to a specific element of a vector, use the same notation that you use for C++ arrays:

```cpp
myOtherVector[2] = 0.05;
```

To append a value to the end of the vector, which will make the vector one element longer, use the `push_back()` method:

```cpp
myVector.push_back(0.015);
```

To find out the current length of a vector, use the `size()` method:

```cpp
Int_t length = myVector.size();
```

Here’s a simple code fragment that loops over the elements of a vector and prints them out.

```cpp
for (Int_t i = 0; i != someVector.size(); ++i )
{
    std::cout << "The value of element " << i << " is " << someVector[i] << std::endl;
}
```

You have a vector, but TGraphErrors wants a C++ array name. Here’s the trick:

```cpp
// Define four vectors.
std::vector<Double_t> x,y,ex,ey;
// Put values in the vectors (omitted so you can do it!)
Int_t n = x.size();
TGraphErrors* plot = new TGraphErrors(n, x.data(), y.data(),
    ex.data(), ey.data());
```

In other words, if `v` has the type `std::vector<Double_t>`, then `v.data()` is equivalent to the underlying `Double_t` array.
Exercise 12: Create a basic x-y plot (1-2.5 hours)

You’re going to re-create that “pun plot” that I showed during my initial talk.\footnote{106}

Number of charged atoms in ‘Nights in the Gardens of Spain’

![Plot of charged atoms over time]

Figure 45: Can you spot the pun in this plot? 
Hint: It involves the composer of a piece of music for piano and orchestra written in the early 20th century.

Use the histograms in folder example1 from the file folders.root. The y-values and error bars will come from fitting each histogram to a gaussian distribution; the y-value is the mean of the gaussian, and the y-error is the width of the gaussian.

You’ve spent five pages reading about abstract concepts and are probably eager to do some work, but there’s still a couple of things you’ll have to figure out.

(continued on next page)

\footnote{106} For Python programmers: if you use an appropriate routine from matplotlib, you’ll have to figure out how to get that mathematical formula to label the y-axis of the plot. This page may help you get LaTeX expressions (see footnote 53) into your axes labels: \url{http://matplotlib.org/users/usetex.html}
Exercise 12: Create a basic x-y plot (continued)

First of all, there’s no ntuple in this exercise. You’ll have to create a ROOT or pyroot macro to create the graph on your own.\(^{107}\) You’ve seen some macros before (remember c1.C?), and you’ll find many more in the ROOT tutorials.

Want to see more examples of using TGraphErrors? Look at the ROOT tutorials directory. The problem is that there are lots of examples; how do you find those that use TGraphErrors? I copied the ROOT tutorials directory (see page 61), and then I used the UNIX grep command:

```
> cd tutorials
> grep –rl TGraphErrors *
```

This will list the names of the files that contain the text “TGraphErrors”. That’s how I found out how to draw a TGraphErrors plot inside a ROOT canvas.

The UNIX grep command is very useful; type `man grep` to learn about it.\(^{108}\)

You need to figure out how to get the x-values. In this case, it’s relatively simple. There are only six histograms in the example1 folder. In TBrowser, double-click on the histograms and read the titles. The histograms are numbered from hist0 to hist5; so you can derive a formula to go from the histogram index to the value of x.

You already know how to open a ROOT file within a macro (it was part of exercise 10 on page 58), but it’s not obvious how to “navigate” to a particular folder within a file. Look at the description of the TFile class on the ROOT web site. Is there a method that looks like it might get a directory? (continued on next page)

---

\(^{107}\) You could try typing the commands on the ROOT command line one-by-one. Unless you have a shining grasp of ROOT concepts and perfect typing skills, you’re going to make mistakes that will involve many quit-and-restarts of ROOT. It’s much easier to write and edit a macro (or use a Jupyter notebook).

\(^{108}\) Another tangent:

`grep` is a program that interprets “regular expressions” (also known as “regexes”), a powerful method for searching, replacing, and processing text. More sophisticated programs that use regular expressions include `sed`, `awk`, and `perl`; there are also regex libraries in Python and C++. Regexes are used in manipulating text, not numerical calculations, so their deep nitty-gritty is rarely relevant in physics.

Regular expressions are a complex topic, and it can take a lifetime to learn about them. (You may be tired of the joke, but I’m not!)

There’s a cool xkcd cartoon about regular expressions. It’s too big to put into a footnote, so you’ll have to click on the link yourself: [https://xkcd.com/208/](https://xkcd.com/208/)
Exercise 12: Create a basic x-y plot (continued)

By now, you’ve probably learned that for ROOT to know where to look to plot, read, or write something, it has to know where to “focus.” If an object requires focus in some way, it will have a cd() method (short for “change directory”). Based on that hint, and what you can see on the TFile web page, something like this might work:

```cpp
TDirectory* example1 = inputFile->GetDirectory("example1");
exmaple1->cd();
```

The histograms are numbered 0 to 5 consecutively. It would be nice to write a loop to read in “hist0”, “hist1”, … “hist5” and fit each one. But to do that, you have to somehow convert a numeric value to a text string.

If you know C or C++, you already know ways to do this (and in Python it’s trivial). If all this is new to you, here’s one way to do it:

```cpp
#include <sstream> // put this near the top of your macro
for ( Int_t i = 0; i != 6; ++i )
{
    std::ostringstream os;
    os << "hist" << i;
    TString histogramName = os.str();
    // … do what you need to with histogramName
}
```

There are other problems you’ll have to solve:

- **How do you read a histogram from a file? Or the more general question is: How do you get a ROOT object from a file?**
  
  Hint: How do you “find” an object in a TFile? (Once you’ve figured this out, look through the tutorial files for more clues.)

- **Once you fit a histogram to a gaussian distribution, how do you get the mean and width of the gaussian from the fit?**
  
  Hint: The TH1 page lists the method you’ll need.

(hints continued on next page)
Exercise 12: Create a basic x-y plot (continued)

- In Figure 45, the x-axis is logarithmic. How do you make that change?
  Hint: Remember how you found out how to label an axis?

- Speaking of axis labels, how do you put in $\frac{n_{\text{true}}}{d(Falla)}$?
  Hint: look up TLatex in the ROOT web site. You don’t have to declare a TLatex object; just put the text codes into the axis label and ROOT will interpret them.

- How do you get the marker shapes and colors as shown in the plot?
  Some looking around the ROOT web site should give you the answer.

Now you can get to work!
Exercise 13: A more realistic x-y plotting task (1-2 hours)

It took nine pages to set up the previous exercise. It only takes one page to describe this one. Don’t be fooled: this exercise is harder!

Take a look at folder example2 in folders.root. You’ll see histograms and an ntuple named histogramList. Right-click on histogramList and Scan the ntuple. On the ROOT text window, you’ll see that the ntuple is a list of histogram ID numbers and an associated value.

Once again, you’re going to fit all those histograms to a gaussian and make an x-y plot. The y values and error bars will come from the fits, as in the previous exercise. The x values will come from the ntuple; for example, the value of x for histogram ID 14 is 1.0122363.

I’ll let you pick the axis labels for this graph; don’t make the x-axis logarithmic.

You’ve probably already figured out that you can use MakeSelector on the histogramList ntuple, just like you did on page 46. The challenge will be putting together the code inside the Process method of the new class with code from the previous exercise.

In the previous exercise, perhaps you hard-coded the number of histograms in the folder. Don’t do that here. You could get the number of histograms from the number of entries in the ntuple.

Or maybe that’s not a good idea; what if there were an entry in the ntuple but no corresponding histogram? Keep a separate count of the number of “valid” histograms you’re able to read. This means you’ll have to check if you’ve read each histogram correctly.

C++ tip: If a ROOT operation to read a pointer fails, that pointer will be set to zero (see page 105).
Part Seven – Expert Exercises

Exercise 14: A brutally realistic example of a plotting task (1-2 hours)

Now take a look at folder example3. You probably already looked in there and were overwhelmed with the number of histograms.

Here’s the task: it’s another x-y plot, with the y values and error bars from fitting the histograms. You only want to include those histograms whose names begin with “plotAfterCuts”; the other histograms you can ignore.

The x values come from the histograms themselves. Double-click on a few histograms to plot them. You’ll see that the x values are in the titles (not the names!) of the histograms.

You’ll be able to re-use code you developed for the previous two exercises. There are some new problems to solve: how to get the list of all the histograms in the example3 folder, how to test if a histogram’s name begins with “plotAfterCuts”, and how to convert a histogram’s title from string form to a number.

Let’s think about the easier problems first.

If you’re fairly familiar with C or C++, you probably already know how to convert strings into numbers. If you’re not, then I suggest you take a look at the description of the TString class on the ROOT web site; the Atof() method looks interesting.

The TString class is pretty good about converting string formats implicitly.\(^{109}\) You probably already figured out how to look up getting the title from a histogram. The method returns “const char *” but something like this will work:

```cpp
TString title = histogram->GetTitle();
```

What about testing if the text in a TString begins with “plotAfterCuts”? Take another look at the TString web page. Is there a method that looks like it might help you with that test?

\(^{109}\) Yet another digression: There are three main ways of handling strings in ROOT/C++:

- The original way from the older language C, as an array of char: `char oldStyleString[256];`
- A newer way, added to the C++ language: `std::string newStyleString;`
- The ROOT way: `TString rootStyleString;`

Which is better? My attitude is that none of them is best. In a ROOT program, I tend to use TString; if my program doesn’t use ROOT, I use `std::string` for string variables and arrays of char for constant strings.

Until recently, C++ didn’t have the built-in text manipulation facilities of languages like perl or Python. This can be important in a physics analysis procedure; while your calculations are based on numbers, manipulating files or program arguments can be based on strings. A language update, C++11, has a “regex” library for handling regular expressions; this can also be found in ROOT’s cling.

In Python, all this is much simpler. (Hint: `import re`)
**Exercise 14 (continued)**

The next problem is trickier: How do you get a list of objects in a directory?\(^{110}\)

By now you’ve got the hang of the above hint: I want to “Get” a “List” of objects in a directory. When I worked on this problem, I went to the TFile web page and looked for methods with names that began with “GetList”. Nothing there, so I went to the parent class TDirectoryFile, continuing to search for “GetList.” Nothing there, so I went to its parent TDirectory. I found something, clicked on the name of the method... then pounded my head against the desk.\(^{112}\)

I finally got the answer by using the UNIX grep command to search through the ROOT tutorials directory for the text “GetList”. There are many files there with a “GetList...” call, but one file name stood out for me. Since I had read the TList web page first, I could see that the answer was there. But it’s sloppily written and you’ll have to change it.

To understand what you’d have to change, you’ll have to know a little bit about class inheritance. In C++, the practical aspect of class inheritance is that you can use a pointer to a base class to refer to a derived class object; if class Derived inherits from class Base, you can do this:

```
Base* basePointer = new Derived();
```

If that’s a little abstract for you, consider this in terms of the classes with which you’ve worked. Any of the following is correct in C++:\(^{113}\)

```
TH1D* doublePrecisionHistogram = new TH1D(...);
TH1* histogram = new TH1D(...);
TObject* genericRootObject = new TH1D(...);
```

Why does this matter? Because ROOT does not read or write histograms, functions, ntuples, nor any other specific object. *ROOT reads and writes pointers to class TObject.* After you read in a TObject*, you’ll probably want to convert it to a pointer to something useful.

---

\(^{110}\) For Python programmers: This discussion of object inheritance is relevant to you as well, but you deal with it in a different way. Look up the Python `type()` and `isinstance()` functions.

\(^{111}\) TFile’s “grandparent.”

\(^{112}\) I suppose the programmer thought that they would write the documentation for GetList later.

Here’s a tip for writing code that will make you a hero: “later” does not exist. (As of 2016, the ATLAS collaboration collected over 35 fb\(^{-1}\) of data, and they still haven’t discovered evidence of “later”!) Treat the comments as part of the code-writing process. If you have to edit the code, edit the comments.

Yes, I know it’s a pain. But pounding your head on a desk is a bigger pain. It’s the biggest pain of all when you realize that you wrote the code yourself six months ago, have completely forgotten what it means, and must now spend an hour figuring it out. It would have taken five seconds to write a comment.

\(^{113}\) How do you figure out which classes derive from where? As I noted in footnote 104 on page 72, the only way to find out in the current ROOT documentation is to search ROOT’s C++ source code, which you can browse via the links to the .h files in the class’ web page. Welcome to the wild adventure hunt that is ROOT!
Exercise 14 (continued)

In C++, the simplest way to attempt to convert a base class pointer to a derived class pointer something like this (assuming genericRootObject is a TObject*):

```c++
TH1* histogram = (TH1*) genericRootObject;
If ( histogram == NULL )
{
    // The genericRootObject was not a TH1*
}
else
{
    // The genericRootObject was a TH1*; you can use it for things like:
    histogram->FillRandom("gaus",10000);
    histogram->Draw();
}
```

If I didn’t put that test in there and just tried histogram->FillRandom("gaus",10000), and histogram==NULL, then the program would crash with a segmentation fault.\(^{114}\)

![Figure 47](http://xkcd.com/371) by Randall Munroe

Why did I just take two pages to go over such a dry topic?

- Understanding object inheritance makes it clear why the macros that ROOT automatically creates for you use pointers, why ROOT’s container classes only contain TObject*, why the default canvas is a TCanvas* c1, etc.
- It’s so when you see a line like this in the ROOT tutorials, you have an idea of what it’s doing: using a TKey to read in a TObject*, then converting it to a TH1F*:

```c++
h = (TH1F*)key->ReadObj();
```

Now you should have an idea of how to edit this line to do what you want to do... and how to check if what you’ve read is actually a histogram or is some other object that was placed inside that folder.

\(^{114}\) If you haven’t encountered a segmentation fault yet in this tutorial, you’re either very lucky or very good at managing your pointers. Now you know why it happens: someone tried to call a method for an object that wasn’t there.
**Exercise 15: Data reduction (1-2 hours)**

Up until now, we've considered ntuples that someone else created for you. The process by which a file that contains complex data structures is converted into a relatively simple ntuple is part of a larger process called "data reduction." It's a typical step in the overall physics analysis chain.

As I implied in the first day of this tutorial, perhaps you’ll be given an ntuple and told to work with it. However, it’s possible you’ll be given a file containing the next-to-last step in the analysis chain: a file of C++ objects with data structures. You’d want to extract data from those structures to create your own ntuples.\(^{115}\)

Copy files whose names contain “Example” from my root-class directory:

```bash
> cp ~seligman/root-class/*Example* $PWD
```

The file exampleEvents.root contains a ROOT tree of C++ objects. The task is to take the event information in those C++ objects and reduce it to a relatively simple ntuple.

First, take a look at ExampleEvent.h. You’re not going to edit this file. It’s the file that someone else used to create the events in the ROOT tree. If you’re given an ExampleEvents object, you can use any of the methods you see to access information in that object; for example:

```c
ExampleEvent* exampleEvent = 0;
// Assume we assign exampleEvent somehow.
Int_t numberLeptons = exampleEvent->GetNumberLeptons();
```

For this hypothetical analysis, you’ve been told that the following information is to be put into the ntuple you’re going to create:

- the run number;
- the event number;
- the total energy of all the particles in the event;
- the total number of particles in the event.
- a boolean indicator: does the event have only one muon?
- the total energy of all the muons in the event;
- the number of muons in the event;

The task is to write the code to read the events in exampleEvents.root and write an ntuple to a different file, exampleNtuple.root.

---

\(^{115}\) If you’re trying to get through the advanced exercises using Python, this one may stump you; it certainly stumps me. I know of no simple way of loading a C++-based ROOT dictionary using Python. Something like this may be a start:

```python
ROOT.gInterpreter.ProcessLine('#include "ExampleEvent.h"')
ROOT.gSystem.Load("./libExampleEvent.so")
```
**Exercise 15 (continued)**

After what you’ve done before, your first inclination may be to open exampleEvents.root directly in ROOT and look at it with the TBrowser. Try it. It doesn’t fail, but you’ll get an error message about not being able to find a dictionary for some portions of the ExampleEvent class. I mentioned this earlier in footnote 30 on page 27: it’s possible to extend ROOT’s list of classes with your own by creating a custom dictionary. Only classes that have a dictionary defined can be fully displayed using the ROOT browser.

Try to see how much of the ExampleEvent tree you can see without the dictionary. Then restart ROOT and type the following ROOT command:

```cpp
[] gSystem->Load("libExampleEvent.so");
```

This causes ROOT to load in the code for a dictionary that I’ve pre-compiled for you. Now you can open the exampleEvents.root using a TFile object and use the ROOT browser to navigate through the ExampleEvent objects stored in the tree.

As you look at the file, you’ll see that there’s a hierarchy of objects. There’s only one object in the file, exampleEventsTree. Inside that tree, there is only one “branch”, exampleEventsBranch.

That’s a bit of a clue: a ROOT ntuple is actually a TTree object with one Branch for every simple variable.

(continued on the next page)

---

116 If you didn’t get such a message, then you probably copied my entire root-class directory to your working directory. That’s OK, but you might want to temporarily create a new directory, go into it, start ROOT, and open the file just so you can see the error message. That way you’ll know how it looks if you have a missing-dictionary problem.

117 This library may not work if you’re on a different kind of system than the one on which I created the library. If you get some kind of load error, here’s what to do:

Copy the following additional files from my root-class directory if you haven’t already done so:

- LinkDef.h
- ExampleEvent.cxx
- BuildExampleEvent.cxx
- BuildExampleEvent.sh

Run the UNIX command script with:

```
> sh BuildExampleEvent.sh
```

This will (re-)create the libExampleEvent shared library for your system. It will also create the program BuildExampleEvent, which I used to create the file exampleEvent.root.

If you’re running this on a Macintosh, the name of the library will be libExampleEvent.dylib; that’s the name to use in the gSystem->Load() command in the Mac version of ROOT.
**Exercise 15 (continued)**

At this point, you could use MakeSelector() to create a ROOT macro for you, but I suggest that you only do this to get some useful code fragments to copy into your own macro. Some additional hints:

- The first line of your ROOT macro for this exercise is likely to be the library load command on the previous page.
- If you’re writing a stand-alone program, instead of loading the library you’ll have

```
#include “ExampleEvent.h”
```

and include libExampleEvent.so on the line you use to compile your code.
- Look at the examples in the tutorials/tree directory, on the TTree web page, and in the macro you created with MakeSelector (if you chose to make one).
- Yes, the ampersands are important!

One more hint:

How do you tell if a lepton is a muon or an electron? I’m not talking about their track length in the detector, at least not for this example. I’m talking about what indicator is being used inside this example TTree.

There’s a standard identification code used for particles. The Particle Data Group developed it, so it’s called the “PDG code”. There are methods in the TTree that return this value (e.g., `LeptonPDG`). You can find a complete list of codes at [http://pdg.lbl.gov/2002/montecarlorpp.pdf](http://pdg.lbl.gov/2002/montecarlorpp.pdf). For this exercise, these will do:

<table>
<thead>
<tr>
<th>Particle</th>
<th>PDG Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>e⁻</td>
<td>11</td>
</tr>
<tr>
<td>e⁺</td>
<td>-11</td>
</tr>
<tr>
<td>µ⁻</td>
<td>13</td>
</tr>
<tr>
<td>µ⁺</td>
<td>-13</td>
</tr>
</tbody>
</table>

If the sign of the PDG codes for leptons seems puzzling to you, recall that under the usual particle-physics nomenclature, electrons are assigned a lepton number L of +1, positrons are assigned L=-1, and so on.

Get to work!

---

118 Why don’t I want you use MakeSelector here? The answer is that some physics experiments only use ROOT to make ntuples; they don’t use it for their more complex C++ classes. In that case, you won’t be able to use MakeSelector because you won’t have a ROOT dictionary. It’s likely that such a physics experiment would have its own I/O methods that you’d use to read its physics classes, but you’d still use a ROOT TTree and branches to write your ntuple.
### Particle Properties in Physics

<table>
<thead>
<tr>
<th>Property</th>
<th>Type/Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electric Charge</td>
<td>-1 0 +1</td>
</tr>
<tr>
<td>Mass</td>
<td>0 (1) (10) (20) (30)</td>
</tr>
<tr>
<td>Spin Number</td>
<td>-1 (\frac{1}{2}) (\frac{3}{2}) (1)</td>
</tr>
<tr>
<td>Flavor</td>
<td>Misc. Quantum Numbers</td>
</tr>
<tr>
<td>Color Charge</td>
<td>(\times) (8) (Quarks Only)</td>
</tr>
<tr>
<td>Mood</td>
<td>😞 😞 😞 😞 😞</td>
</tr>
<tr>
<td>Alignment</td>
<td>Good–Evil, Lawful–Chaotic</td>
</tr>
<tr>
<td>Hit Points</td>
<td></td>
</tr>
<tr>
<td>Rating</td>
<td>★★★★★</td>
</tr>
<tr>
<td>String Type</td>
<td>Bytestring–Charstring</td>
</tr>
<tr>
<td>Batting Average</td>
<td>0% 100%</td>
</tr>
<tr>
<td>Proof</td>
<td>0 200</td>
</tr>
<tr>
<td>Heat</td>
<td>0 200 400</td>
</tr>
<tr>
<td>Street Value</td>
<td>$0 $100 $200</td>
</tr>
<tr>
<td>Entropy</td>
<td>(This already has like 2D different confusing meanings, so it probably means something here, too)</td>
</tr>
</tbody>
</table>

Figure 48: [https://xkcd.com/1862/](https://xkcd.com/1862/) by Randall Munroe

Alt-text: Each particle also has a password which allows its properties to be changed, but the cosmic censorship hypothesis suggests we can never observe the password itself—only its secure hash.
Wrap-up

The last four exercises that make up Parts Six and Seven are difficult. I chose those tasks because they represent the typical kind of work that I find myself doing whenever I use ROOT: pulling together documentation from different places, translating the examples into the work I’m actually doing… and pounding my head against the desk whenever there are no comments, or I get yet another segmentation fault.\footnote{\textsuperscript{119}}

If you’d like to see how I solved those same exercises, you’ll find my code in PlotGraphs.C (for exercises 13-15) and MakeNtuple.C (for exercise 16).\footnote{\textsuperscript{120}}

Good luck!\footnote{\textsuperscript{121}}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{xkcd_722.png}
\caption{\url{http://xkcd.com/722} by Randall Munroe
Alt-text: “This is how I explain computer problems to my cat. My cat usually seems happier than me.”}
\end{figure}

\begin{itemize}
\item Now you know the reason for my going bald!
\item Maybe you’re thinking, “Wow! It’s lucky I turned to the last page before I actually started doing any of the work!” Take my word for it: reading my solutions is not a substitute for working through the problem yourself.
\item Total lifetimes used up: up to nine, depending on if you chose to learn both ROOT/C++ and pyroot, which tangents you took, how much LaTeX you learn, and whether you choose a career in physics. I generously give any remaining lives back to you.
\end{itemize}
Version History

2020
I sincerely hope that by the time you read this, the impact of the 2020 pandemic will have faded into irrelevance. There could be no organized summer student program at Nevis that year, and certainly no in-person ROOT tutorial. However, I decided to update the tutorial anyway.

The primary changes were to Part Five:

- I moved more optional material into Part Five, so it would be less distracting for those going through the tutorial page-by-page, but still be available as a reference.
- I also offered more detailed options for installing ROOT and Jupyter on your laptop.

2019
Included “intermediate topics” in a new Part Five, to act as a reference for useful material that the students may not immediately need for summer research. This brings the number of parts to seven.

2017
We now have a Jupyterhub-based notebook installation available to Nevis students. I’ve incorporated this into the lessons. It’s now a six-part course, but the part introducing notebooks is quite short.

2016
I’ve edited the Python portion to use IPython instead of the “vanilla” Python console.

The ROOT web site has changed, and its class documentation is now even worse than it was before. (Yay!) I’ve done my best to revise this course for those changes.

2015
Many changes in response to feedback from the working groups:

- Upgrade to ROOT 6, which affected the exercises and examples for Part Four and Five.
- The TreeViewer is back in the course.
- A few more “this is what it should look like” figures added (along with more xkcd cartoons).
- Most of the working groups now have their students use Python for their summer work.
- The C++ portion on creating a code skeleton for reading an ntuple now uses the newer MakeSelector method instead of the older MakeClass method.

2014
At the request of some of the experimental groups, I added a parallel track in pyroot, the Python wrapper around ROOT. The student can choose to learn ROOT/C++, pyroot, or both. This increased the size of the tutorial to five parts, but up to three of these parts are optional.
2010

In response to student feedback, what had been one full day of work was split into two half-day classes. Instead of eliminating the advanced exercises, I divided the two days of the 2009 class into four parts, each part roughly corresponding to a half-day’s work. This allows each student to set their own pace and gives experienced programmers a challenge if they need it.

2009

I was asked to expand the class to two full days. In past years, many students weren’t able to complete all the exercises that were intended to be done in a single day. I added a set of advanced exercises for students who knew enough C++ to get through the original material quickly, but allowed for the rest of the students to do in two days what earlier classes had been asked to do in one.

Figure 50: [https://xkcd.com/2224/](https://xkcd.com/2224/) by Randall Munroe